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CHAPTER
ONE

MODEL CREATION SUMMARY

This section summarizes the steps involved in creating a finite element knee model. The summary includes links to
other chapters where specific details are provided. This chapter also describes the inputs and outputs of each step.

These steps apply to the OpenKnee(s) data set. The documentaiton for the DU data set can be found in a separate
document.

Additionally, ligaments and tendons are modeled as bundles of springs, however the steps for modeling these tissues
as a continuum are also documented. This additional documentation is included to prevent excessive use of revisions
if it is decided to represent ligaments and/or tendons as a continuum.

1.1 Image Segmentation and Reconstruction

The MR images are used to define two types of data
1. Label maps
2. Insertion sites (for spring representation)

Label maps are used to represent 3D geometry, and that geometry is reconstructed into surfaces. The insertion sites
are used to define ligament and tendon geometry that are modeled as bundles of springs. The ligaments and tendons
that are modeled as bundles of springs do not need label maps or surface models.

The segmentation process is described in the image segmentation (page 7) section, and the reconstruction process is
described in the geometric reconstruction (page 42) section. The process used to define ligament and tendon insertion
sites and geometry are described in the /igament and tendon meshing (page 49) section.

Ligaments and tendons are modeld as bundles of springs. One spring is defined by connecting one insertion point to
another. Multiple springs are used to represent a ligament, and these springs are linearly distributed across the insertion
area. To achieve this, the user places two points at the margins of each insertion area (4 total for each ligament/tendon).
The insertion areas as identified using literature descriptions of soff tissue anatomy (page 15). The specific details on
how this process are described in the /igament and tendon meshing (page 49) section.

If in the future, a ligament and/or tendon is being modeled as a continuum, then the geometry should be segmented
(page 7) and reconstructed (page 42) like the other geometry.

1.1.1 Segmentation Inputs

* MR images
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1.1.2 Segmentation Outputs

The outputs of segmentation are label maps that are defined from the MR images.
* Label maps
— Femur
— Tibia
Patella

Femur cartilage

Tibia cartilage

Patella cartilage

Medial meniscus

Lateral meniscus

* Insertion sites for ligament/tendon spring model (4 points defined with respect to the MR image coordinate system)

— Ligaments

— Tendons

1.1.3 Reconstruction Inputs

The label maps that are output from segmentation are the inputs for geometric reconstruction (page 42). These inputs
are the label maps for the femur, tibia, patella, cartilage, and medial and lateral meniscus. Ligaments and tendons are
modeled as bundles of springs, therefore they do not have label maps, and they are not reconstructed into surfaces.

If in the future, a ligament and/or tendon is being modeled as a continuum, then ligament/tendon label maps created
during segmentation (page 7) should be reconstructed into surfaces.

1.1.4 Reconstruction Outputs
Geometric reconstruction uses the label maps to define surfaces. One surface is created for each label map, and these
surfaces are saved as .stl files.

» Femur surface .stl

* Tibia surface .stl

* Patella surface .stl

» Femur cartilage surface .stl

* Medial tibial cartilage surface .stl

* Lateral tibial cartilage surface .stl

* Patella cartilage surface .stl

* Medial meniscus surface .stl

¢ Lateral meniscus surface .stl

1.1. Image Segmentation and Reconstruction 2
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1.2 Mesh Creation

The surfaces that were created during the /mage Segmentation and Reconstruction (page 1) are used to create the solid
meshes that are used in the finite element model. The bones and cartilage are modeled as rigid bodies, so the surfaces
created for the femur, tibia, and patella are used as the finite element meshes for those geometries. The cartilage
is being modeled using an elastic foundation model (/LKST15] (page 87),:cite:halloran_comparison_2005), so the
meshes for the femoral cartilage, tibial cartilage (medial and lateral) and the patellar cartilage are being converted into
quadrilateral dominated surfaces. The menisci are modeled as solids, and the surfaces are used to create hexahedral
meshes, and the hexahedral meshes are used in the finite element model. If in the future, a ligament and/or tendon
is being modeled as a continuum, then the geometry should also be meshed using hexahedral elements following the
same procedure as used for meshing the menisci.

Specific details on the meshing process are described in the meniscus meshing (page 47) and cartilage meshing
(page 48) sections.

The insertion points for the ligaments and tendons are used to define the individual fibers that connect the insertion
sites. The insertion sites are used to define the initial ligament and tendon geometry. See the ligament and tendon
meshing (page 49) section for more details on ligament and tendon mesh creation.

Note that the number of elements used in the ligament, cartilage, and menisci geometry will be determined with
convergence studies.

1.2.1 Meshing Inputs

* Solid Geometry
— Medial meniscus surface (.stl)
— Lateral meniscus surface (.stl)
¢ Elastic Foundation Geometry
— Femur cartilage surface (.stl)
— Medial tibial cartilage surface (.stl)
— Lateral tibial cartilage surface (.stl)
¢ Rigid Geometry
— Femur surface (.stl)
— Tibia surface (.stl)
— Patella surface (.stl)
¢ Ligament and Tendon Geometry
— Insertion sites (4 points defined with respect to the MR image coordinate system)
— Desired number of fibers for each ligament and tendon

— Desired number of “cross elements” for each ligament and tendon (see ligament and tendon meshing
(page 49) for more information)

1.2.2 Meshing Outputs

* Solid Geometry

— Medial meniscus hexahedral mesh (abaqus .inp file)

1.2. Mesh Creation 3
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— Lateral meniscus hexahedral mesh (abaqus .inp file)
¢ Elastic Foundation Geometry (rigid)

— Femur cartilage quadrilateral dominated mesh (abaqus .inp file)

Medial tibial cartilage quadrilateral dominated mesh (abaqus .inp file)

Lateral tibial cartilage quadrilateral dominated mesh (abaqus .inp file)
— Patellar cartilage quadrilateral dominated mesh (abaqus .inp file)
* Rigid Geometry
— Femur triangular surface mesh (abaqus .inp file)
— Tibia triangular surface mesh (abaqus .inp file)
— Patella triangular surface mesh (abaqus .inp file)
* Initial Ligament and Tendon Geometry
— Ligament spring mesh (abaqus .inp file, one file for each ligament)

— Tendon spring mesh (abaqus .inp file, one file for each tendon)

1.3 Reference Simulation

The initial ligament and tendon meshes are defined by connecting insertion points with straight lines, and they may
overclose the bones, cartilage, and menisci. A reference simulation is used to make the ligaments and tendons wrap
around any bodies that they may initially overclose. The purpose of the reference simulation is to modify the node
positions of the initial ligament and tendon meshes to account for wrapping. The reference state mesh (page 51) and
reference simulation boundary conditions (page 69) sections describes this process in more detail.

a. - b.

24

2

Fig. 1.1: An example of (a) the initial mesh that is defined from insertion point to insertion point data, and (b) the
reference state where the ligament’s mesh wrapped around the femur and tibia surfaces. Note that this is used as an
example, and not used to describe the insertion locations or size of any specific ligament.

1.3.1 Reference Simulation Inputs

* Solid Geometry
— Medial meniscus hexahedral mesh (abaqus .inp file)
— Lateral meniscus hexahedral mesh (abaqus .inp file)

¢ Rigid Geometry

1.3. Reference Simulation 4
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Femur cartilage mesh (abaqus .inp file)

Medial tibial cartilage mesh (abaqus .inp file)

Lateral tibial cartilage mesh (abaqus .inp file)

Femur triangular surface mesh (abaqus .inp file)

Tibia triangular surface mesh (abaqus .inp file)

Patella triangular surface mesh (abaqus .inp file)
* Initial Ligament and Tendon Geometry
— Ligament spring mesh (abaqus .inp file, one file for each ligament)

— Tendon spring mesh (abaqus .inp file, one file for each tendon)

1.3.2 Reference Simulation Outputs

¢ Updated Ligament and Tendon Geometry (new node positions)
— Ligament spring mesh (abaqus .inp file, one file for each ligament)

— Tendon spring mesh (abaqus .inp file, one file for each tendon)

1.4 Coordinate Systems

The rigid body coordinate systems are defined for the femur, tibia, and patella. Specific details on those processes can
be found in the coordinate systems (page 52) section.

These rigid body coordinate systems are used to define connector elements, and the nodes that compose the connector
elements. These elements are used to assign boundary conditions and/or loads to the joint coordinate system, and to
also measure joint motion with respect to the joint coordinate system. The specific information on connector element
definition can be found in the connector elements (page 56) section.

1.4.1 Coordinate Systems Inputs

* User selected points from MR images
— Femoral landmarks
— Tibial landmarks

— Patellar landmarks

1.4.2 Coordinate Systems Outputs

* Connector element definitions (abaqus .inp file)

1.5 Interactions and Ties

Rigid ties are used to simulate insertions of the ligament, tendons, and meniscal attachments. Similarly, the cartilage
is rigidly tied to the corresponding bone. Interactions are used to define contact between different bodies.

1.4. Coordinate Systems 5
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This section does not have specific inputs or outputs. The ties and interactions are described in the interactions and
ties (page 65) section, and the sequence with interactions are activated are described in the simulation steps (page 69)
section.

1.6 Simulation Steps and Boundary Conditions

The different steps used in a FEA simulation, and boundary conditions are described in the simulation steps and
boundary conditions (page 69) section.

In general, the passive flexion simulation starts with applying a nominal 20 N load to the quadricep along the quadri-
cep’s line of action (page 58), while the femur and tibia are fixed. This is followed by the femur being flexed from
it’s initial position to O degrees flexion. The 20 N quadricep load is maintained, and a 20 N compressive load is also
applied to the femur throughout this step.

The last step in the passive flexion simulation flexes the femur about it’s medial-lateral axis from 0 to 90 degrees.
There is a nominal 20 N compressive load applied to the joint to maintain joint contact. Similarly, there is a nominal
20 N load applied to the quadricep to maintain contact between the femur and the patella.

1.7 Model Outputs

The model outputs are measured from the finite element simulation results. Custom Python scrits are used to
read/extract the desired results from the simulation’s results file. The outputs are described in the Model Outputs
(page 80) section.

The main output variables are:
* Contact (area, force, and pressure)
¢ Joint kinematics

 Ligament forces

1.6. Simulation Steps and Boundary Conditions 6



CHAPTER
TWO

IMAGE SEGMENTATION

2.1 Introduction

This section contains the process of partitioning an MR image into multiple segments(sets of pixels, i.e. Label Map).
In this process a label is assigned to each pixel in an MR image so that pixels with the same label represent a specific
structure (e.g. bone, ligament, cartilage, etc). These segments will be used to create the volumetric reconstruction of
the desired tissue or bone.

To familiarize yourself with the segmentation software and procedure, first review Loading Data into Slicer (page 8),
Segmentation Procedure (page 10), Label Map Smoothing (page 12) and Generate Triangulated Surface (STL) from
Label Map (page 12)) sections then move on to Tissue Specific Procedure (page 13) section for guidline on suggested
steps for segmentation of bones, cartilage and soft tissues.

2.2 Prerequisite

3D Slicer: 3D Slicer is an open source software platform for medical image informatics, image processing, and
three-dimensional visualization https://www.slicer.org/ .

2.3 Inputs

2.3.1 OpenKnees Data

Sets of MRI in NifTI format (.nii). Download the desired image from the desired specimen (click here for the download
links). Selection of desired MRI set depends on the tissue you want to segment. Each of these MRI sets are suitable
for visualization of specific anatomical structures of the knee.

 For segmentation of bones and cartilage, it is recommended to use Cartilage MRI (MRC) which is a 3D T1-
weighted with fat suppression, anisotropic voxel size, gradient echo, with sagittal plane resolution of approx-
imately 0.35 mm, and an out-of-plane resolution of approximately 0.7 mm. Start off the segmentation at the
sagittal plane and refer to the coronal and axial planes to get better visualization of boundaries.

 For segmentation of ligaments, it is better to use Connective Tissue MRI (MRL) for insertion sites definition.
Connective Tissue MRI consists of three image sets each corresponding to one of the anatomical planes (i.e.
MRL-s:sagittal, MRL-c:coronal and MRL-a:axial). They are all Multi Echo Spin Echo (MESE) sequence with
an in-plane resolution of approximately 0.35 mm, and an out-of-plane resolution of approximately 2.8 mm.
Based on the desired ligament, you may start off the segmentation at sagittal plane or coronal plane window.

¢ General Purpose MRI (MRG) will be used for segmentation of registration markers. This MRI set is a 3D
T1-weighted without fat suppression, isotropic voxel size with with 0.5 mm x 0.5 mm x 0.5 mm resolution.



https://www.slicer.org/
https://simtk.org/frs/?group_id=485
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Specimen/Sample Labeling protocols

Labeling protocols will be followed for each structure, which allows use of pre- and post-processing procedures to be
generically applied after segmentation.

¢ 0ks003: Open Knee Specimen 3
* Bone:

— FMB: Femur
TBB: Tibia

FBB: Fibula
— PTB: Patella

 Cartilage:
— FMC: Femoral Cartilage
— TBC: Tibial Cartilage
— PTC: Patellar Cartilage
» Ligaments:

— amAcl (page 15): Anteromedial Bundle of Anterior Cruciate Ligamnet

plAcl (page 15): Posterolateral Bundle of Anterior Cruciate Ligamnet

— alPcl (page 17): Anterolateral Bundle of Posterior Cruciate Ligament

— pmPcl (page 17): Posteromedial Bundle of Posterior Cruciate Ligament

— sMclProx (page 20): Proximal Fibers in Superficial Bundle of Medial Collateral Ligament
— sMclDist (page 20): Distal Fibers in Superficial Bundle of Medial Collateral Ligament
— dMcl (page 20): Deep Bundle of Medial Collateral Ligament

— lcl (page 23): Lateral Collateral Ligament

— all (page 25): Anterolateral Ligament

— pfl (page 26): Popliteofibular Ligament

— oplIMid (page 26): Middle Portion of Oblique Popliteal Ligament

— pMFL (page 37): Posterior Meniscofemoral Ligament (Ligament of Wrisberg)

— aMFL (page 37): Anterior Meniscofemoral Ligament (Ligament of Humphrey)

— Mpfl (page 28): Medial Patellofemoral Ligament

— Lpfl (page 29): Lateral Patellofemoral Ligament

2.4 Loading Data into Slicer

Detailed procedures for loading the above described MRI data sets are given to help reduce the uncertainty for repro-
ducibility across groups. Note the segmentation procedure, which applies to each tissue (7issue Specific Procedure
(page 13)), is described below. In Slicer, to load MRI data in NifTI format use the following steps (for loading
OpenKnees data):

* Click data button from the top toolbar section or goto File > Add Data.

2.4. Loading Data into Slicer 8
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¢ Click Choose File(s) to Add, select desired MRI file (.nii) and click Open. 3 volume slices (axial,
sagittal and coronal) will appear in the slice viewers (red, yellow and green windows). you can choose between
a number of predefined layouts of these viewer windows from the layout drop-down menu.

— A slider is provided at the top of each viewer windows for manually going through slices and a slice
number entry widget is also provided at the top right of each viewer for manually indexing a particular
slice.

— You can change the brightness and contrast of the images by clicking the default mouse cursor and dragging
up/down or left/right in any 2D viewer windows.

— Hover you mouse over the pin icon on the top left corner of the red slice viewer to display the slice viewer
controller. Click on the chain icon to link the slice viewers. By doing so, the configuration options and
interactions will apply across all slice viewers otherwise options apply only to the viewer being adjusted.

Load segmented label maps:
* Click data button from the top toolbar section or goto File > Add Data.
* Click Choose File(s) to Add, select desired label map file (.nrrd or .nii).

* Check the Show Options box on top right of the window. A couple of checkboxes will appear in front of the
name of the file you have selected. For label maps always check the Labe1Map box.

¢ Click Open.

2.4.1 Notes

Following points will be useful throughout the segmentation procedure.

1. Display the slice view controller window by moving your mouse over the pin icon on the top left corner of any of
the slice viewer you want. The panel may be opened persistently by clicking on the pin icon.

» you will see 3 layers (L, F, B) specific options (If you can not see layers option click on the double arrow icon
for showing all the options).

» Layer labeled as “L” is the current Label Map Volume that you are editing. You can switch between available
Label Maps using the drop-down menu. The visibility of the Label Map can be changed using the spinbox
widget, from 0.0 (transparent) to 1.0 (opaque). You can toggle between showing the Label Map with regions
outlined or filled using the square icon next to the spinbox.

* Layer labeled as “B” is the Background Layer. In the Editor module the background gray-scale is known
as the Master Volume since it is used as the input for Editor module tools (e.g. PaintEffect,
DrawEffect,etc). Note that you can load multiple MRI sets into Slicer (e.g. those that are cartilage spe-
cific or ligament specific). Any of these MR images can be used as the background layer, you can toggle
between them using the background layer drop-down menu. For example one may wish to create the label map
volume based on a high resolution MRI and then edit it while looking at a low resolution MRI. If you are doing
so, make sure that you first create your label map based on the Master Volume you have already chose in
the Editor module.

* Layer labeled as “F” is the Foreground Layer. Two label maps can be overlayed on the MRI in order to compare
label map boundaries between two different structures. The label map you want to edit should be set as the label
layer (L). The other label map can be loaded as the foreground layer (F). You can control the opacity of the
Foreground label using the spinbox opacity widget next to it.

2. In the lower left corner of each slice viewer, three layers mentioned above and their assigned image/label are being
displayed.

3. Crosshair options are available for precise cross-correlation between slice viewers. Click on the Crosshair
drop-down menu in the toolbar. It provides a set of options for customizing the appearance and behavior of the

2.4. Loading Data into Slicer 9
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crosshair across all slice viewer windows. Hold Shift and move mouse in a slice view to position the Crosshair
in all slice viewers.

4. It’s recommended to save your work frequently, to avoid repeating all the tedious work through program crashes.
Click on Save icon on the toolbar, a list of different files with different names and formats will appear. By default,
Slicer will select the scene and any modified data sets. You can change this selection using checkboxes in the leftmost
column or through three shortcuts icon on the top left of the panel. Make sure to change the directory of each file in
the directory column. To save label map volumes you have to make sure to select the file with the same name as your
Merge Volume inthe Editor module with .nrrd or .nii format.

2.5 Segmentation Procedure

2.5.1 Manual Segmentation

» After loading a volume (MR images) enter the Editor module from the toolbar. Editor module is used for
manipulating label map volumes.

o If this is the first time entering Editor, you will be prompted to choose a color table. Select the
GenericAnatomyColors. If this is not the first time, the result of previous editing will be automatically
selected when you enter Editor module.

e Under the Create and Select Label Maps tab, there is a Master Volume drop-down menu. The
MRI set displaying in slice viewers is automatically selected as the Master Volume. You can change it using
the drop-down menu.

* If your background is named “x1”, the label will be automatically named “x1-label”. You can create a new one
under the Merge Volume drop-down menu and then click Create a new LableMapVolume. If you
have loaded a previously segmented label map, make sure that the label map being edited in the slice viewers is
the same as the Merge Volume.

» Highlight the anatomy of interest in every slice, in each image orientation as appropriate (coronal, sagittal,
axial).

— If you want to segment multiple structures from one MRI, it is better to create separate label maps for each
of them. Before start highlighting the structure of interest, under Create and Select Label Maps
tab and in Per—-Structure Volumes section click the Add Structure . You will be prompted to
choose a color (label value) based on the Color Table selected when the Merge Volume was created. In
such cases the Merge Volume will contain all the structures (label maps).

* Different tools are available in Editor module to highlight anatomy of interest:

— Use the Paint Effect (under Edit Selected Label Map tab, third icon from left, on the top
row) with an appropriate/largest radius, to fill in the area using a brush. Select the Sphere checkbox to
also applies the radius to slices above and below the current slice. In this case you have to be careful on
your brush size since it will also paint in other slices and it may overlap with other structures. To avoid
this issue try not to highlight areas very close to boundaries of anatomy of interest and after you are done
highlighting, make sure to go through all slices and check for overlaps. In general, spherical brush is a
handy tool for segmenting big structures (e.g. femur and tibia). It will help you saving a lot of time doing
highlighting.

— Use the eraser (under Edit Selected Label Map tab, second icon from left, on the top row) to

change the behaviour of the tool, e.g. brush or pencil, to erase rather than draw.

— Use the Draw Effect (under Edit Selected Label Map tab, forth icon from left, on the top row) to
draw the boundaries of the area. By dragging mouse right click lay down a continuous line to outline the
structure of interest (use “x” key to delete the last point added) and then left click to fill in the outline.

2.5. Segmentation Procedure 10
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2.5.2 Grow Cut Segmentation

 Perform first three steps of Manual Segmentation (page 10)

¢ Choose the paint brush effect and highlight the anatomy of interest (L1) on roughly equally-spaced slices in
each image plane orientation as appropriate (coronal, sagittal, axial)(Fig. 2.1)

e Under Edit Selected Label Map tab, change the label value (color) to highlight the area around the
anatomy of interest (L2) on the slices you have also highlighted the anatomy itself(Fig. 2.1).

 In an image plane orientation other than the one you are highlighting in, cap the area around the anatomy of
interest to prevent L1 label leakage (Fig. 2.2).

¢ Click the GrowCutEffect (third icon from left on the bottom row). Make sure the L1 label (associated with
the anatomy of interest) is selected under the Label drop-down menu and then hit the Apply button. Slicer
window graphics will freeze until the grow cut algorithm is complete.

¢ Remove the L2 label color (colors around the anatomy of interest) using ChangeLabelEffect. Choose the
L2 label as the selected Label and also as the Input Color and choose background label (black color) as the
Output Color and click the Apply button.

'

,
P
!
¥
#
9

Fig. 2.2: Grow Cut Segmentation, after performing label leakage control.

2.5. Segmentation Procedure 11
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2.5.3 Notes

Some shortcuts in Editor module:
¢ f move to next slice
* b, move to previous slice
e 7 ,undo

e y,redo

Shift , scroll other slices to mouse location
* h, toggle the crosshair and put it into navigator mode

* e, toggles from the current color to 0 and back (use this while painting or drawing to quickly erase if you go
over the line)

* ¢, show color picker

* Escape, cancel current effect

* p, select Paint effect

¢ d, select Draw effect

* w, select Wand effect

* r, select Rectangle effect

* Space , bring up tool selection window at current mouse location
- or _, shrink the current radius by 20%

* +or =, grow the current radius by 20%

2.6 Label Map Smoothing

Following smoothing step will be performed to remove the noises and outliers remaining from the grow cut segmen-
tation step. This smoothing procedure is on the voxel level and will preserve the volume.

e From the Modules drop-down menu, select Surface Models > Label Map Smoothing.

¢ Set Gaussian Smoothing Parameters, Sigma based on image resolution (e.g. 0.7 for cartilage MRI, resolution =
0.35 x 0.35 x 0.7 mm).

e From Input Volume drop-down menu, select desired label map.
e From Output Volume drop-down menu, select Create new Volume as....
¢ Enter new name as desired, click OK.

e Click Apply.

2.7 Generate Triangulated Surface (STL) from Label Map

e From the Modules drop-down menu, select Surface Models > Model Maker.
e Under IO tab, from Input Volume drop-down menu, select desired label map.

* InModels drop-down menu, either Create new ModelHierarchy as... (e.g. defaultis ‘Models’), or
select an existing Model Hierarchy. All models can be generated under the same or separate model hierarchies.

2.6. Label Map Smoothing 12
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e Under Create Multiple tab, specify a desired Model Name for the selected label map.
* For creating raw STL models:

— Under Model Maker Parameters tab, set Smooth to zero.

— Under Model Maker Parameters tab, set Decimate to zero.
* Click Apply button.

e Enter the Editor module and select the MakeModelEffect (second icon from right on the bottom row)
under Edit Selected Label Map tab.

* Set desired label map as the Merge Volume. If no smoothing is desired, deselect Smooth Model.
* Click Apply button.

* A 3D model of the label map will appear on the 3D view window. Roll your mouse over the pushpin icon on
the blue bar across top of the 3D viewer window to open the configuration panel.

¢ Click on the Save icon on the toolbar. By default, 3D models will be saved with .vtk format. you can change it
from the File Format drop-down menu in front of the file name. Make sure to choose the desired directory
for saving the file.

2.8 Output

Output of the segmentation procedure is the triangulated surface representation of the tissue of the interest (.STL) in
the raw and unfiltered format.

2.9 Tissue Specific Procedure

In the following sections segmentation procedure for bones, cartilage and soft tissues will be specifically described.

2.9.1 Bone & Cartilage Segmentation Procedure

Input: Cartilage MRI
Procedure:
e Perform Grow Cut Segmentation (page 11) on desired bone.
e Perform Label Map Smoothing (page 12) to remove Grow Cut boundary noise.

e Perform Manual Segmentation (page 10) to more accurately define bone/cartilage boundary. It will be helpful to
overlay the General Purpose MRI (as the Foreground label) on the Cartilage MRI in order to get a more accurate
boundary definition.

* Iteratively repeat last two steps until boundary is as desired.

It is better to perform cartilage segmentation along with the bone segmentation. This way you can use bone boundaries
to define cartilage boundaries, just remember to define a separate label map volume for the cartilage.

2.9.2 Soft Tissue Segmentation Procedure

Input: Connective Tissue MRI (MRL)

Procedure:

2.8. Output 13
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* Load sagittal ligament MRI
» Perform Manual Segmentation (page 10)
» Perform Label Map Smoothing (page 12)

¢ In order to have a high resolution segmentation volume from a low resolution MRI, one can open Cartilage MRI
and Connective Tissue MRI in different viewer windows. When windows are linked Slicer uses interpolation
for coupled viewing and you can use Cartilage MRI as the Master Volume and segment the soft tissue on
the interpolated MRI.

¢ Alternatively, You can segment the tissue on the Connective Tissue MRI and then lay the label map over the
Cartilage MRI (as the Foreground Layer, make sure to increase the opacity, the default is zero) Create a
new label map as the Merge Volume and start to segment the soft tissue. Use the Connective Tissue MRI
label map as a guideline for the boundaries of the tissue.

2.9. Tissue Specific Procedure 14



CHAPTER
THREE

SOFT TISSUE ANATOMY

This section is a annotated bibliography for the soft tissue anatomy that is represented in the knee models. It is used
to provide a description of the soft tissue anatomy that is being modeled.

Note: Many of the descriptions are copy and pasted from the literature. Citations are included in the descriptions,
however they are not properly quoted. This documentation is for internal use only, and descriptions should be quoted
or revised before publication.

Tibiofemoral:

3.1 ACL Anatomy

This section describes the ACL anatomy, including the bundles represented in the model and the femoral and tibial
insertion sites.

3.1.1 General Description

¢ Femoral insertion: posterior part of the inner surface of the lateral femoral condyle /DBA+06] (page 84)

— Size can vary from 11 to 44 mm across (‘across’ not defined) [DBA+06] (page 84)

« Tibial insertion: a fossa located anterior and lateral to the medial tibial spine. Fibers ‘fan out’ as they approach the tibial

— The fosa is approximately 11 mm wide (range of 8 to 12 mm), and the anterior-posterior length is 17
mm (range, 14-21 mm) [DBA+06] (page 84)

e Length: 22 to 41 mm (mean 32 mm) /DBA+06] (page 84)

This lab models the ACL as two distinct bundles, the anteromedial (amACL) and the posterolateral (plACL) bundles.
These names are derived from their insertion on the tibial plateau.

3.1.2 amACL

» Femoral insertion: The most superior and anterior part of the insertion
* Tibial insertion: The most anteromedial aspect of the tibial insertion

* Length: 34 mm in extension (like most MR images used in the lab) [DBA+06] (page 84).

15
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Fig. 3.1: The amACL (labeled AMB) and plACL (labeled PLB) bundles [ DBA+06] (page 84).

Fig 3A-B. (A) This figure shows a lateral femoral
condyle. The anteromedial bundle is located high and
deep in the intercondylar fossa, whereas the postero-
lateral bundle is located more low and shallow. Be-
cause arthroscopic surgery is normally performed
with the knee in 90° of flexion, in the clinical literature
the notch roof is considered high (anatomic descrip-
tion, anterior), the anterior rim is considered shallow,
the posterior part is considered deep, and the poste-
rior part is considered low. (B) The pesterior end of
the intercondylar fossa is marked by the intercondylar
line (arrows). This line borders on the Facies poplitea
(FP) of the distal femur. The AM origin is located at
the transition of the intercondylar line to the articular
cartilage.

Fig. 3.2: The amACL and plACL femoral insertions [PZ07] (page 84).

Lateral Lateral

Fig. 3.3: General tibial insertions of the amACL and plACL bundles /[TLG+ 18] (page 84).

3.1. ACL Anatomy 16
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Fig.1 aAnteromedial (AM: a
blue) and posterolateral (PL:

red) bundle fibres of the ACL

are d

MR images. b A
3D model of proximal left tibia
with AM and PL insertion sites
was created from the MRI slices
using the Mimics® software.
Medial meniscus is shown
in this figure. ¢ The lateral
meniscus (LM) is segmented
and shown in 3D. The overlap
of ACL fibres and anterior horn
of lateral meniscus (AHLM)
is also segmented and recon-
structed in 3D (green area
indicated with arrow)

Fig. 3.4: Segmentation of the amACL and plACL bundles [TLG+18] (page 84). This shows one way to differentiate
between the AM and PL bundles in the MR images.

Note:

When modeling the ligament as a bundle of nonlinear springs that are linearly mapped across the insertion site:

* The femur’s proximal point corresponds with the tibia’s more anteromedial point

* The femur’s distal point corresponds with the tibia’s more posterolateral point

3.1.3 plACL

* Femoral insertion: The most distal and posterior part of the insertion
* Tibial insertion: The most posterolateral aspect of the tibial insertion

* Length: 22.5 mm in extension (like most MR images used in the lab) [DBA+06] (page 84).

Note:

When modeling the ligament as a bundle of nonlinear springs that are linearly mapped across the insertion site:

* The femur’s proximal point corresponds with the tibia’s more anterior point

* The femur’s distal point corresponds with the tibia’s more posterior point

3.2 PCL Anatomy

This section describes the PCL anatomy, including the bundles represented in the model and the femoral and tibial
insertion sites.

3.2. PCL Anatomy 17
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3.2.1 General Description

» Femoral insertion: The femoral insertion can span from the trochlear notch to the inner surface of the medial
femoral condyle. The femoral attachment of the PCL extends more than 20 mm in an anterior—posterior (AP)
direction across the roof and medial side of the femoral intercondylar notch J/AGBEO5] (page 84).

* Tibial insertion: posterior aspect of the tibia, between two prominences which are the posterior aspects of the
medial and tibial plateau [AZW+12] (page 84).

The lab models the PCL as two functional bundles, the anterolateral (alPCL) and posteromedial (pmPCL).

ALB
pMFL

\ |

\ '\

PCL facet V \
lateral

cartilage

droprolf (COD)

Fig. 3.5: The alPCL (labeled ALB) and pmPCL (labeled PMB) bundles [AZW+12] (page 84).

3.2.2 alPCL
¢ Femoral insertion: approximately 112 mm”2 in area, with the center being ~7.4 mm to the trochlear point, and
~7.9 mm from the distal articular cartilage Fig. 3.7 [AZW+12] (page 84).

* Tibial insertion: t approximately 88 mm”2 in area. The insertion is anterior to the pmPCL tibial insertion. The
center of the insertion area is ~8.6 mm from the lateral cartilage point Fig. 3.9 [AZW+12] (page 84).

Note:

When modeling the ligament as a bundle of nonlinear springs that are linearly mapped across the insertion site:

* The femur’s more anterior point corresponds with the tibia’s more lateral point

* The femur’s more posteriomedial point corresponds with the tibia’s more medial point

3.2. PCL Anatomy 18
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medial arch point

trochlear point

g ‘ terior

. B /P"i’“

LMFL4
bifurcate prominence

medial intercondylar
ridge

Fig. 3.6: The alPCL (labeled ALB) and pmPCL (labeled PMB) femoral insertions for a right knee [AZW+12]
(page 84).

iy

medial bi " -
intercondylar ifurcate @
3 ridgey prominence —V A

posterior point —=%

Fig. 3.7: The alPCL (labeled ALB) and pmPCL (labeled PMB) femoral insertions for a right knee [AZW+12]
(page 84).

f lateral cartilage
shiny white _—* _~ point
fiber point ALB &

K
BMB TS0

" bundle ridge

medial groove

champagne-glass
drop-off

Fig. 3.8: The alPCL (labeled ALB) and pmPCL (labeled PMB) tibial insertions for a right knee [AZW+12] (page 84).

3.2. PCL Anatomy 19
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popliteus m.

medial
groove

champagne-glass
drop-off (CGD)

lateral
cartilage
point

shiny white
fiber point

Fig. 3.9: The alPCL (labeled ALB) and pmPCL (labeled PMB) tibial insertions for a right knee [AZW+12] (page 84).

3.2.3 pmPCL
* Femoral insertion: approximately 60 mm”?2 in area, with the center being about ~18.8 mm from the trochlear
point and ~8.6 mm from the distal articular cartilage Fig. 3.7 [AZW+12] (page 84).

* Tibial insertion: approximately 105 mm”2 in area. The insertion is posterior to the alPCL tibial insertion Fig.
3.7 Fig. 3.6. [AZW+12] (page 84).

Note:

When modeling the ligament as a bundle of nonlinear springs that are linearly mapped across the insertion site:

¢ The femur’s more anterior point corresponds with the tibia’s more lateral point

* The femur’s more posterior point corresponds with the tibia’s more medial point

3.3 MCL Anatomy

This section describes the MCL anatomy, including the bundles represented in the model and the femoral and tibial
insertion sites.

3.3.1 General Description

This lab models the MCL as three distinct bundles. Two of those bundles compose the superficial MCL (sMCL), and
one bundle represents the deep MCL (dMCL). The sMCL has one femoral and two two tibial attachments [LaP07]
(page 84), one tibial insertion is more proximal to the joint line (psMCL), and the other is more distal to the joint line
(dsMCL). The tibial attachments are used to differentiate the two sMCL bundles.

3.3.2 Proximal sMCL

* Femoral insertion: the attachment is located in a depression that is slightly proximal and posterior to the medial
femoral epicondyle. The center of the attachment side is 6.4 mm (3.9 to 9.6 mm) from the medial femoral
epicondyle, and 26.8 mm (13.1 to 32.2 mm) from the femoral joint line (assumed to be in extension). The
insertion area is approximately 94.1 mm”2 (60.1 to 143.8 mm”2) [LaP07] (page 84) (appendix).

3.3. MCL Anatomy 20
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Meniscofemoral
ligament
Meniscotibial
ligament

sMCL (proximal
tibial)

sMCL (distal
tibial)

Fig. 3.10: The insertions of the MCL [LaP07] (page 84).

Add\lflur magnus
e

AT
Medial gastrocnemius
tendon altachment site

Medial
meniscus
i

gastrocnemius POL and
endon (retracted) POL posteromedial
attachment capsule
site 3.

Fig. 3.11: The insertions of the IMCL [LaP07] (page 84).

3.3. MCL Anatomy
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Fig. 3.12: The insertions of the IMCL /LYG+10] (page 84).

3.3. MCL Anatomy
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* Tibial insertion: the tibial insertion is described as connecting to the semimembranosus tendon, and the tendon
inserts into the tibia. This is modeled as a direct attachement of the psMCL into the tibia (this describes the
semimembranosus tendon tibial attachment from [LaP07] (page 84)). The center of the attachment is located
12.2 mm (8.8 to 15.3 mm) to the tibial joint line. The attachment area is approximately 221.5 mm”2 (104.7 to
609.2 mm”2).

3.3.3 Distal sMCL

* Femoral insertion: the attachment is located in a depression that is slightly proximal and posterior to the medial
femoral epicondyle. The center of the attachment side is 6.4 mm (3.9 to 9.6 mm) from the medial femoral
epicondyle, and 26.8 mm (13.1 to 32.2 mm) from the femoral joint line (assumed to be in extension). The
insertion area is approximately 94.1 mm”2 (60.1 to 143.8 mm”2) [LaP07] (page 84) (appendix).

* Tibial insertion: just anterior to the posteromedial crest of the tibia. The distance from the center of the at-
tachment to the joint line is approximately 61.2 mm (52.4 to 70.5 mm). The attachement area is approximately
294.3 mm”2 (212.4 to 356.8 mm"2) [LaP07] (page 84) (appendix).

3.3.4 Deep MCL

The deep MCL (dMCL) has an insertion into the medial meniscus [LaP07] (page 84)[LYG+10] (page 84). The
definition of this insertion is described in dMCL and Meniscus Ties (page 67).

* Femoral insertion: width (anterior-posterior) 9.9 4 3.2 mm, with an area of 71.9 £ 14.8 mm”2, and the center
of the insertion area is 20.5 &+ 4.2 mm from the femoral joint line, and 13.0 & 2.7 mm from the medial femoral
epicondyle /[LYG+10] (page 84).

* Tibial insertion: width (anterior-posterior) 18.0 & 4.0 mm, with an area of 63.6 £ 13.4 mm”2, and the center of
the insertion area is 6.5 £ 1.3 mm inferior to the tibial joint line /LYG+10] (page 84).

Note: This section references [LaP07] (page 84), and the appendix for this article can be found on the journal’s
website. The appendix appears to be freely available, so a subscription to the journal is not needed.

3.4 LCL Anatomy

This section describes the LCL anatomy, including the femoral and fibular insertion sites.

3.4.1 General Description

» Femoral insertion: slightly superior and posterior to the lateral femoral epicondyle. There is a small bony
depression that the ligament inserts into. The insertion area is approximately 48 mm”2 (range, 43 to 52
mm”\2):cite:laprade_posterolateral_2003.

* Fibular insertion: Attaches to the lateral aspect of the fibular head. The insertion is approximately 28.4 mm
(range 25.1 to 30.6 mm) from the apex of the fibular head. The insertion area is approximately 43 mm”2 (range,
39 to 50 mm”2) [LLWEO3] (page 84).

e Length: 69.6 mm (range, 62.6 to 73.5) [LLWEO3] (page 84).

3.4. LCL Anatomy 23
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Popliteofibular
Ligament

Fig. 3.13: The LCL (labeled fibular collateral ligament) anatomy for a right knee /LLWEO3] (page 84).

LGT Origin

Fibular
Styloid

Fig. 3.14: The LCL (labeled FCL) anatomy for a right knee /LLWEO3] (page 84).

3.4.

LCL Anatomy
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3.5 ALL Anatomy

This section describes the anterolateral ligament (ALL) anatomy, including the femoral and tibial insertion sites.

3.5.1 General Description

» Femoral insertion: located on the prominence of the lateral femoral epicondyle, anterior to the socket from
which the LCL originated, and proximal and posterior to the insertion of the popliteus tendon. The width is 8.3
4+ 2.1 mm [CVM+13] (page 84).

* Tibial insertion: the width is 11.2 & 2.5 mm, and the distance from the tibial articular cartilage and the insertion
(assuming center) is 6.5 &= 1.4 mm. The distance from the center of the insertion to the fibular head is 23.2 +
5.7 mm [CVM+13] (page 84).

[ Gerdy's Tubercle |

Popliteofibular Ligament |

Fig. 3.15: The ALL anatomy for a right knee /CVM+13] (page 84).

Fig. 3.16: The ALL anatomy for a right knee /CVM+13] (page 84).

3.5. ALL Anatomy 25
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3.6 PFL Anatomy

This section describes the popliteofibular ligament (PFL) anatomy, including the femoral and fibular insertion sites.

3.6.1 General Description

The popliteofibular ligament originates at the fibular styloid process and attaches to the popliteus tendon. The PFL
courses proximodistally from the fibular attachment [LLWEO3] (page 84) into the popliteus tendon, however this is
not represented in the model. The model uses the popliteus tendon femoral insertion as the PFL’s femoral insertion.
The PFL/popliteus tendon is medial to the LCL.

e Femoral insertion: the femoral insertion of the popliteus tendon is used at the PFL’s femoral insertion. The
insertion is anterior to the LCL femoral attachment. The center of the insertion area is 15.8 mm (range, 11.2
to 18.6) from the lateral femoral epicondyle. The area of the insertion is 59 mm”2 (range,53 to 62) Fig. 3.18
[LLWEO3] (page 84).

« Fibular insertion: near the tip of the fibular styloid process. The PFL is described as having separate anterior
and posterior attachments /[LLWEO3 ] (page 84), however the model represents a single attachment.

Popliteofibular
Ligament

Popliteofibular
Ligament

Fig. 3.17: The PFL anatomy for a right knee [LLWEO03] (page 84).

3.7 OPL Anatomy

This section describes the oblique popliteal ligament anatomy, including the femoral and tibial insertion sites.

3.7.1 General Description

The OPL has two distal insertions, however the model represents the OPL as having only one tibial insertion that is
just lateral to the PCL insertion. The medial aspect of the OPL is formed by “a confluence of the lateral expansion off
the semimembranosus common tendon” [LaP07] (page 85). Given that the laxity tests do not activate the muscles, the
medial aspect of the OPL is assumed to not be recuruited throughout testing, and is not represented in the model.

3.6. PFL Anatomy 26
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LGT Origin

Fibular
Styloid

Fig. 3.18: The femoral insertion of the popliteus tendon (labeled PLT) [LLWEO3] (page 84).
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The OPL attaches proximally to an osseous or cartilaginous fabella, and blends into the posterolateral capsule at the
posterolateral aspect of the distal part of the femur /[LaP07] (page 85). The model does not represent the fabella, so
the femoral attachment is taken as the attachment of the posterolateral jonit capsule to the

» Femoral insertion: inserts into the posterolateral joint capsule at the medial border of the lateral femoral condyle
[HSM+17] (page 85). The model represents the femoral insertion site as on the lateral side of the lateral femoral
condyle near the superior margin of the cartilage.

* Tibial insertion: lateral to the PCL tibial attachment, with an attachment length of 10.4mm (range, 7.0 to 14.0).

SM Posterior

capsule ., Plantaris

-\

capsular arm

Lateral gastroc

Fabella

Fabellofibular

. ligament
Coronary )
attachment Popliteus

capsular
. extension
Anlerior arm—¢.___
\ FCL
Direct arm

PCL \

Medial arm of
distal expansion

Lateral arm of
distal expansion

Fig. 3.19: The posterior view of a right knee showing the OPL [LaP07] (page 85).

Patellofemoral:

3.8 MPFL Anatomy

This section describes the medial patellofemoral ligament (MPFL) anatomy, including the femoral and patellar inser-
tion sites.

3.8.1 General Description

The MPFL attaches at the medial epicondyle of the femur to the proximal part of the medial border of the patella.

3.8. MPFL Anatomy 28
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Fig. 3.20: Axial MR images showing the OPL [HSM+17] (page 85).

» Femoral insertion: attaches to the anterior aspect of the medial epicondyle, and the superior aspect of the MCL
was in direct contact with the most inferior edge of the MPFL. Width (proximal to distal) is 15.4 mm (range,
11-20 mm) [SDMO04] (page 85). The area of insertion site is 25.9 mm”2 (range, 22.7-29.2 mm”"2) [KCM+18]
(page 85).

* Patellar insertion: The vertical distance from the superior pole of the patella to the level of the superior edge
of the MPFL is 6.1 mm (range, 0-13 mm). The vertical distance from the superior pole to the inferior edge of
the MPFL is 23.1 mm (range, 15-29 mm). Width (proximal to distal) is 17 mm (range, 14-20 mm) [SDMO04]
(page 85). The area of patellar insertion site is 37.6 mm”2 (range, 26-49.2 mm"2) [KCM+18] (page 85).

e Length: 56.6 mm (range, 54.2-58.8 mm) [KCM+18] (page 85).

3.9 LPFL Anatomy

This section describes the lateral patellofemoral ligament (LPFL) anatomy, including the femoral and patellar insertion
sites.

3.9.1 General Description
The lateral patellofemoral ligament is located in the deep retinacular layer. It is attached to the lateral patella as its
widest part and anchored to the lateral femoral epicondyle with fan-like expansions [CZE+17] (page 85).

e Femoral insertion: The LPFL originated, on average, 2.6 mm distal (range, 13.1 mm proximal to 11.4 mm
distal) and 10.8 mm anterior (range, 7.3 mm posterior to 14.9 mm anterior) to the lateral epicondyle. Overall,
the absolute distance (Fig. 3.27) from the epicondyle was 14.5 mm (range, 10.6-20.6 mm). The average width
of the femoral insertion is 11.7 mm (range, 9-13.9 mm) [SDW+17] (page 85).

* Patellar insertion: The LPFL insertion on to the patella is about 45% (range, 23.7%-58.4%) of its lateral articular
surface and is in the middle third of the lateral patella. The average width of patellar insertion is 14.3 mm (range,
8.1-16.8 mm) [SDW+17] (page 85).

e Length: 23.2 mm (range, 12.4-40 mm) [CZE+17] (page 85).

3.10 Patellar Tendon Anatomy

This section describes the patellar tendon anatomy, including the tibial and patellar insertion sites.
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Fig. 3.21: The MPFL anatomy for a right knee /KCM+18] (page 85).
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Fig. 3.22: Medial view of a left knee showing the patellar insertion site of MPFL (green) relative to the patellar
articular cartilage (dotted line) [KCM+18] (page 85).

MIPTL

Tibial
Tubarcle

Fig. 3.23: Coronal and sagittal views of a left knee showing the positioning of the center of attachment of MPFL
relative to the surgical relevant landmarks [KCM+18] (page 85).
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Coronal View

Mean Distance . . .
(95% CI), mm Directionality

MPFL femoral attachment from

Adductor Tubercle (AT) 9.2 (7.8-10.6) Dsital

Gastrocneius Tubercle (GT) 3.5 (2.3-4.6) Proximal
Medial Epicondyle (ME) 14.1 (10.8-17.5) Proximal
Femoral Condylar line 36.5 (34.7-38.2) Proximal

Sagittal View

Mean Distance . ) .
(95% Cl), mm Directionality

MPFL femoral attachment from

Adductor Tubercle (AT) 9.7 (8.6-10.8) Dsital

Gastrocneius Tubercle (GT) 10.4 (7.9-12.9) Anterior
Medial Epicondyle (ME) 15.2 (12.8-17.6) Proximal
Posterior Femoral Cortex 8.3 (5.1-11.5) Anterior

Extension line

Fig. 3.24: Radiographic measurements of the distances between MPFL attachment center and pertinent anatomic
osseous landmarks on the femur on coronal and sagittal view [KCM+ 18] (page 85).
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Fig. 3.25: The lateral patellofemoral ligament (LPFL) [noa] (page 85).
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Fig. 3.26: LPFL outlined in a cadaveric specimen. (A) After disection, the patella is reflected laterally providing an
intra-articular view of the LPFL (outlined in black). (B) Lateral image of the knee with the LPFL outlined in black
[SDW+17] (page 85).

Fig. 3.27: Image showing the absolute distance (black double headed row) from the center of LPFL femoral insertion

to the tip of the lateral epicondyle. In this case the femoral attachment was distal and anterior to the lateral epicondyle
[SDW+17] (page 85).
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L. ™

Fig. 3.28: Distance D is calculated to determine the width of the LPFL patellar insertion.

3.10.1 General Description

The patellar tendon (PT) extends from the inferior pole of the patella to the tibial tuberosity [LAF 2] (page 85).

* Tibial insertion: is an irregular pentagonal shape with a medially directed superior apex and is widest proximally
(Fig. 3.31). The mean tendon insertion width (Iw in Fig. 3.31 ) of 23.9 +/- 3.0 mm is nearly half that of the
patella width at its greatest dimension (42 +/- 4.5 mm) [DWP+14] (page 85).

e Length: as the distance from the most proximal aspect of the attachment to the inferior pole of the patella is
52.88 +/- 7.56 mm [NRLC+02] (page 85).

3.11 Quadriceps Tendon Anatomy

This section describes the patellar insertion side anatomy of the quadriceps tendon.

3.11.1 General Description

The tendons of the four muscles that make up the quadriceps converge to one insertion on the superior aspect of the
patella /WJHO09] (page 85). The model represents these as one tendon.

* Patellar insertion: width 43.3+/-5.8 mm (range, 34.3 to 54.1 mm) [LAF12] (page 85).

Note: When defining the insertion site for the quadriceps, two proximal points should be defined (one medial and
one lateral). These are used to calculate the line of action of the tendon in the image state.

Menisci:
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Fig. 3.29: Anterior view of a left knee at 90 degree flexion showing the attachments of the patellar tendon [ KCM+18]
(page 85).

Fig. 3.30: A sagittal and axial MRI view of patellar tendon (arrow) [noa06] (page 85).
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Fig. 3.31: Tibial insertion of patellar tendon in a right knee. Surface area landmarks are showing the Inserion Width
(Iw), Insertion height(Ih), Superomedial edge length (A), Superolateral edge length (B), Lateral edge length (C),
Inferior edge length (D) and Medial edge length (E) [DWP+14] (page 85).
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3.12 aMFL Anatomy

This section describes the Anterior Meniscofemoral Ligament (aMFL) anatomy, including the femoral insertion sites.

3.12.1 General Description

The Anterior Meniscofemoral Ligament (aMFL), also known as ligament of Humphrey, arises from the posterior horn
of the lateral meniscus, runs anterior to the PCL and inserts at the distal edge of the femoral PCL attachment [noal8]
(page 86). The average ratio of the cross sectional area of Humphrey to that of the PCL within the same knee is 11.9%
+ 5.7% [KHC+94] (page 86). This ligament may be confused for the PCL [noalS8] (page 86).

e Femoral insertion: Inserts proximally to the inner aspect of the medial condyle of the femur, between the
distal margin of the femoral attachment of the PCL and the edge of the condylar articular cartilage [GSM+02]

(page 86).

* Meniscal insertion: The meniscal attachments of the pMFL followed its orientation in the sagittal plane and
attaches to posterior horn of lateral meniscus. aMFL attachment to the meniscus is more anteriorly than pMFL
[GSM+02] (page 86).

* length: 28.3 mm (range, 20.0-37.0 mm) [YH9!] (page 86).

Fig. 3.32: Photograph showing an aMFL in a cadaver left knee. This clear view is provided by an anterior approach
after removing the ACL and collateral ligaments /GSM+02] (page 86).

3.13 pMFL Anatomy

This section describes the Posterior Meniscofemoral Ligament (pMFL) anatomy, including the femoral insertion sites.
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Fig. 3.33: Femoral insertion of aFML in relation to the insertion of the PCL. Diagrammatic views of the left lateral
femoral condyle in sagittal section demonstrating its anterior (An) and posterior (Po) aspects. (B) Specimen with
aMFL (a) and PCL. (C) Specimen with PCL and coexisting aMFL (a) and pMFL (p):cite:gupte_review_2003.
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3.13.1 General Description

The Posterior Meniscofemoral Ligament (pMFL), also known as ligament of Wrisberg, extends from the posterior
horn of lateral meniscus to medial femoral condyle and lies posterior to PCL. It is usually larger than ligament of
Humphrey [noal8] (page 86). The average ratio of the cross sectional area of Wrisberg to that for the PCL within the
same knee is 12.0 £ 7.7% [KHC+94] (page 86).

* Femoral insertion: It inserts at the medial part of the intercondylar notch near to insertion of the posteromedial
band of the PCL. This is the reason why fibers of the pMFL and PCL sometimes intermingle /noal8] (page 86).

* Meniscal insertion: The meniscal attachments of the pMFL followed its orientation in the sagittal plane and
attaches to posterior horn of lateral meniscus

¢ length: 31.2 mm (range, 27.0-40.0 mm) [YH91] (page 86).

Fig. 3.34: Photograph of a pMFL in a cadaver right knee, as viewed after a posterior approach with the joint capsule
removed. [GSM+02] (page 86).

3.14 Meniscal Horn Attachments

This section describes the anterior and posterior attachemnts of the medial and lateral menisci to the tibia.

3.14.1 General Description

The medial and lateral meniscus both have anterior and posterior attachment sites on the tibial plateau.

Lateral Meniscus

¢ Anterior insertion (alHorn): area of 140.7 mm”2 (+/- 30.0). The center of the attachment is approximately 7.1
mm (+/- 1.3) from the nearest edge of the lateral articular cartilage, and 13.4 mm (+/- 2.1) from the nearest edge
of the posterior lateral meniscus attachment. [LER+14] (page 86)
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Fig. 3.35: Femoral insertion of pFML in relation to the insertion of the PCL. Diagrammatic views of the left lateral
femoral condyle in sagittal section demonstrating its anterior (An) and posterior (Po) aspects. (A) Specimen with
pPMFL (p) and PCL. (C) Specimen with PCL and coexisting aMFL (a) and pMFL (p):cite:gupte_review_2003.
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Posterior

Anterior

Fig. 3.36: The insertions of the meniscal horn attachments /LER+14] (page 86).

Fig. 3.37: The insertions of the meniscal horn attachments [JCP+12] (page 86).

* Posterior insertion (plHorn): area of 39.2 mm”2 (+/- 2.4). The center of the attachment is approximately 12.7
mm (+/- 1.1) from the nearest point on the PCL tibial insertion, and 10.1 mm (+/- 0.8) from the posterior edge
of the anterior root attachment of lateral meniscus [JCP+12] (page 86).

Medial Meniscus

The anterior insertion of the medial meniscus (amHorn) is described as having a central dense root, and supplemental
fiber extensions [LER+14] (page 86). The model will only include the central dense root of the attachment.

* Anterior insertion (amHorn): area of 56.3 mm”2 (+/- 14.9). The center of the attachment is approximately 7.6
mm (+/- 2.3) from the nearest edge of the medial articular cartilage, and 9.2 mm (+/- 2.7) from the nearest edge
of the ACL insertion. [LER+14] (page 86)

* Posterior insertion (pmHorn): area of 30.4 mm”"2 (+/- 2.9). The center of the attachment is approximately 8.2
mm (+/- 0.7) anterior of the most superior tibial attachment of the PCL, and 3.4 mm (+/- 0.4) lateral to the
medial articular edge inflection point. [/CP+12] (page 86)
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CHAPTER
FOUR

GEOMETRIC RECONSTRUCTION

4.1 Introduction

In this section the surface representation of the tissue of interest (.stl) is used to construct the geometric representation
of that tissue. The STL file is the output of the segmentation procedure in raw and unfiltered state. First a brief
introduction to the software and tools that you will be using is proposed. Next, in the Tissue Specific Procedure
(page 46) a guideline is presented for reconstruction of each tissue of interest.

4.2 Prerequisite

MeshLab: MeshLab is a free and open source software for processing and editing 3D triangular meshes. It provides
a set of tools for editing, cleaning, inspecting, texturing and rendering of unstructured large 3D triangular meshes. It
offers features for processing raw data produced by 3D digitization tools/devices (e.g. 3D Slicer) and for preparing
3D models https://www..meshlab.net/ .

4.3 Loading Data into MeshLab

Input: Triangulated Surface representation of the tissue of interest in stl format (.stl).
¢ ClickFile > Import Mesh

* Select the desired .stl file. You can select multiple non-contiguous files by holding Ct r1 or selecting contiguous
ones by holding Shift.

¢ Click Open.

4.3.1 Notes

1. There is no Undo in MeshLab. Please save your work frequently and after every successful step, before losing it
during program crashes (which unfortunately occurs a lot!) or applying a wrong filter!

2. In the toolbar panel on top of the MeshLab main interface, click on the Show Layer Dialog button, a layer
dialog will pop up on the right side of the window. You can get plenty of information about the project from this
dialog.

* On the upper part you have a list of all files/meshes you have already loaded into MeshLab, the highlighted one
in this section is the current layer. This is important since some of the operations of the MeshLab work only
on the current layer. You can change the visibility of a layer by clicking on the eye icon next to each layer. If
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you keep Ct rl button and then select the visibilty of a layer, all other layers will be switched off and the only
visible one is the one you selected.

¢ In the middle part you can handle visualization and rendering modes of meshes. You can manage color, size
and shading/lighting of points, edges and faces in each layer or you can apply your desired settings to all visible
layers by checking the apply to all visible layers box on bottom of this section.

* The lower section is the feedback dialog. You can read there about all the things you have done, loaded and
unloaded and also errors you have been encountered diring an operation.

4.4 Smoothing Procedure

In this section a couple of smoothing procedures will be described in detail and later, in the Tissue Specific Procedure
(page 46) section a guideline will be provided for each specific tissue.

4.4.1 Laplacian Smoothing

* Select desired mesh from the layer dialog panel.
e GotoFilters > Smoothing, Fairing and Deformation > Laplacian Smooth.

* Set Smoothing Steps to whatever value is recommended in the Tissue Specific Procedure (page 46) section
for your desired tissue.

¢ Make sure the Affect only selected faces box is unchecked.
e Click Apply.

— Before hitting the Apply button you can check the Preview box to see how the smoothing will affect
the mesh.

4.4.2 Surface Reconstruction

* Select desired mesh from the layer dialog panel.

* Go to Filters > Remeshing, Simplification and Reconstruction > Surface
Reconstruction: VCG.

e Alter Voxel Side, world unit. Try different values, smaller number means less smoothing. It is rec-
ommended to set world unit value to a meaningful one relative to the original image resolution (e.g. for
cartilage specific images with a resolution of 0.35 x 0.35 x 0.7 mm, use a world unit between 0.35 and 0.7 mm).

* Select Post Merge Simplification.

¢ Click Apply.

4.4.3 Taubin Smoothing

Taubin Smoothing procedure is very useful for smoothing vertices/nodes at sharply curved model edges.

* Select desired mesh from the layer dialog panel (It is better to select parts of the mesh with sharped edges,
guideline for selection is provided in Selecting Procedure (page 44) section).

* GotoFilters > Smoothing, Fairing and Deformation > Taubin Smoothing.

* Select Preview to interactively display current smoothing parameters.
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* It is suggested to set Lambda and mu to their default values (0.5 and -0.53 respectively). Alter them to get the
best result.‘‘Lambda‘‘ should usually be between 0.3 to 1.2 to prevent having jagged meshes.

* Click Apply.

4.4.4 Iso Parametrization

* Before starting the Iso Parametrization procedure make sure that you have saved your work up to this
point.

* Select desired mesh from the layer dialog panel.

* Go to Filters > Remeshing, Simplification and Reconstruction > Iso
Parameterization.

* Use the default settings and click Apply.
Note: Sometimes, the Iso Parametrization will fail and cause Meshlab to crash. If this occurs:
* Deselect Double Step boxinthe Iso Parametrization window and click Apply.

* Or try an increased amount of smoothing (using Laplacian Smoothing (page 43) or Surface Reconstruction
(page 43)) and/or Downsizing (page 45).

o After successfully applying the Iso Parametrization, navigate to Filters > Remeshing,
Simplification and Reconstruction > Iso Parameterization Remeshing.

e Try default Sampling Rate = 10. Alter the Sampling Rate if it is needed (a higher number of sampling
rate creates a higher density triangular surface mesh).

* Click Apply.

4.5 Selecting Procedure

To select a specific portion of surface there are different tools you can use:

e Clickon Select Faces in a rectangular region icon in the toolbar panel on top of the MeshLab
main interface. With this tool you can select faces in a rectangular region. This tool select visible and invisible
faces in this rectangular region (if you turn your model you will see that it has also selected all the faces on the
other side of the model in this rectangular region). it takes a little bit of exercise to make the right selection of
faces. You have to play with navigation to put the model in the proper position to make the right selection.

— If during the selection process you wanted to move the model to a more suitable position to see other sides
of the model, press Esc button to switch to navigation mode. Now you can rotate the model. To switch
back to selecting tool, press Esc button again. If you want to exit from the selecting tool permanently you
have to click again on its icon in the toolbar panel.

— If you press Ct rl key, a plus sign will apear next to the mouse cursor. Now you can add new selection to
the one that has been previously made.

— If you press the Shift key, a minus sign will apear next to the mouse cursor. Now you can subtract part
of already selected region.

* Click on Z-painting tool in the toolbar panel. A window will pop up. On the left side of the window click
on the red head brush and click on the surface of the geometry you want to paint. you can adjust brush size
using the Size widget. Paint tool only select visible surfaces and also you don not need to hit Ctrl key to
select multiple regions. It automatically adds new selection to previous one.
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e Under Filters menu there is a submenu devoted only to selections. There are several ways to select de-
sired regions in a mesh processing style rather than directly interacting with the model and manually tun-
ing it. Their names usually explains their action so they are easy to implement. For example, if you have
small disconnected fragments of stl in your model, go to Filters > Selection > Select small
disconnected component.

4.6 Downsizing

In order to simplify the mesh by reducing number of faces:

e Go to Filters > Remeshing, Simplification and Reconstruction > Quadric Edge
Collapse Decimation.

« Itis suggested to change the visualization mode to flat lines (click on Wireframe icon in the toolbar panel) to
see the density change of the triangles.

e Change the Quality threshold. The higher the value is, your original model’s shape will be preserved.
Suggest value is 0.4.

* Click Apply.

4.7 Cleaning and Repairing

After performing all the smoothing process, we have to make sure that the model is manifold (all edges have exactly
two incident triangles. All vertices have exactly one cycle of incident triangles. All triangles in the mesh are con-
sistently oriented). In the visualization and rendering modes section (middle part of layer dialog), click on the Edge
decorators icon (last icon from the right). A list of On and Of £ switches will appear. Switch on the No-Manif
Verts and Boundary Edges. A box will pop up in the top left corner showing how many of each of these exist
in the model. If the numbers are zero skip to step 7 otherwise:

1. Switch on No-Manif Edges as well.

2. Area relating to these vertices and edges will be highlighted in the model. if you can not see the high-
lighted area, goto Filters > Selection > Dilate Selection, it will expand the current set
of selected faces.

3. Use your preferred selection tool from the Selecting Procedure (page 44) section and select all the
highlighted regions.

4. Select Delete the current set of selected faces and all the vertices
surrounded by that faces.

5. Again, check the number of No-Manif Verts. If it is zero go to the next step to close the holes,
otherwise:

e The remaining No-Manif Verts are the orphan nodes, to delete them go to Filters >
Cleaning and Repairing > Remove Unreferenced Vertices.

6. Go to Filters > Remeshing, Simplification and Reconstruction > Close
Holes. Leave default options and click Apply.

7. GotoFilters > Cleaning and Repairing > Merge Close Vertices. Change the
world unit for the Merging distance based on how close the model’s vertices should be. Use
very small values (suggested value is 0.001). Click Apply.
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8. Go to Filter > Normals,

Curvatures and Orientation > Re-Orient all

faces coherently. This modification is beneficial to the 3D meshing procedure. To see normals
of faces navigate to Render > Show Normal

4.8 Exporting Data from MeshLab

To save your work:

¢ Select your desired layer from the layer dialog panel and goto File > Export Mesh As.

* Navigate to the desired directory for saving the mesh. Change the file type to st 1 format and hit Save.

* A window will pop up. Leave the default settings and click OK.

4.9 Tissue Specific Procedure

In the table below the specific order of smoothing procedures for each tissue and also the parameters related to each
of these smoothing steps has been provided. It is required to perform the Cleaning and Repairing (page 45) procedure
after doing all the smoothing steps below.

Tissue Name | 1. Laplacian | 2. Surface Recon- | 3. Taubin Smooth- | 4. Iso Parametriza-
Smoothing struction (page 43) | ing (page 43) tion (page 44)
(page 43)

Tibia Femur 20 0.7 0.5;-0.53 10

Patella 20 0.5 0.5; -0.53 7

Fibula 20 0.5 0.5;-0.53

Tibial Carti- | 20 0.35 0.5;-0.53 10

lage

Femoral Car- | 20 0.35 0.5;-0.53 15

tilage

Patellar Car- | 20 0.35 0.5;-0.53 10

tilage

Meniscus 20 not needed not needed 8

4.8. Exporting Data from MeshLab
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CHAPTER
FIVE

MODEL SETUP

Contents:

5.1 Mesh Creation

This section describes the procedures that are used to create the geometric mesh that is used in the finite element
model.

Software
Table 5.1: Software used during mesh creation
Program Name Version link
IA_FEMesh https://www.ccad.uiowa.edu/
MIMX/projects/IA-FEMesh
Meshlab 2016.12 https://www.ccad.uiowa.edu/
MIMX/projects/IA-FEMesh
3D Slicer 4.8.1 https://www.slicer.org/
5.1.1 Bone

Triangulated surface mesh is used to represent the geometry of bones in .stl format. If you have already followed all the
steps in the Geometric Reconstruction (page 42) section, the .stl file you have is appropriately meshed otherwise, look
at the Tissue Specific Procedure (page 46) section in Geometric Reconstruction (page 42) section and follow all the
required step for smoothing and re-meshing of your tissue of interest and after that perform Cleaning and Repairing
(page 45) process which is in Geometric Reconstruction (page 42) section aswell.

Table 5.2: Required data after bone segmentation

Description | Mesh Type Comments

Femur sur- | triangle The osseous surface of the femur. This surface is hollow however it should be a
face closed surface.

Tibia  sur- | triangle The osseous surface of the tibia. This surface is hollow however it should be a
face closed surface.

Patella sur- | triangle The osseous surface of the patella. This surface is hollow however it should be a
face closed surface.

5.1.2 Meniscus
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Note: If in the future, a ligament and/or tendon is being modeled as a continuum, then the geometry
should be segmented (page 7) and reconstructed (page 42), the meshed following these procedures.

Mesh Generation

Hexahedral elements are used to represent the geometry of the menisci. The smoothed .stl surfaces (described in Geo-
metric Reconstruction (page 42)) are loaded into IA_FEMesh, and blocks are manually define and oriented around the
surface (Fig. 5.1). The number of seed nodes along the axes of each block should be defined, and the specific number
of seed points should be determined with a convergence analysis. Smoothing should not be used when generating the
mesh (the mesh may be smoothed in later steps).

Fig. 5.1: An example of the blocks setup around a lateral meniscus surface.

5.1.3 Cartilage

The cartilage is being modeled using an elastic foundation model [LKST15]
(page 87),:cite:halloran_comparison_2005. As such, only a surface mesh is needed. The triangular mesh that
was created from the segmentation and reconstruction (page 1) steps is converted into a quadrilateral dominated
mesh. This is performed using MeshLab, where there is an option to convert a triangular mesh into a quadrilateral
dominated mesh. Using MeshLab, the triangular mesh (imported from the .stl file) is converted into a quadrilateral
dominated mesh. The option for Fewer Triangles should be selected. Note that this creates a mesh that may have still
have triangular elements.

The surfaces that are converted into quadrilater] dominated meshes are:
* Femoral cartilage
* Tibial cartilage - medial
* Tibial cartilage - lateral

* Patellar cartilage

Mesh Quality

If the resulting mesh does not approximate the smoothed surface (i.e. the hex mesh has sharp points along surfaces that
are smooth in the input surface), the mesh can be smoothed for 1 or 2 iterations using the E11iptical interpolation
option. If the mesh still does not approximate the smoothed surface, then the number of seed nodes should be increased,
and the surface should be remeshed.

After generating a mesh that matches the input geometry, the mesh should be imported into Abaqus to measure the
mesh quality. Following the Abaqus documentation, the mesh should meet the criteria described in Table 5.3. If all
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of the elements in the mesh do not have the desired quality metrics, then the blocks should be adjusted as needed, and
the geometry should be remeshed. If the desired quality metrics are still not achieved after several iterations, then the
affected geometry should be documented, and the mesh with the best quality elements should be used. Thin areas in
the geometry, such as the inner rim of the meniscus, may not have elements with the desired quality.

Table 5.3: Hexahedral mesh quality metrics found in Abaqus 6.14
documentation, Abaqus/CAE User's Guide in section 17.6.1
Verifying your mesh

Metric Value
Smaller face corner angle 10 deg
Larger face corner angle 160 deg
Aspect ratio 10

Meniscal Attachments

Similar to other studies (/NBJvdG+17] (page 87)), the meniscal attachments are modeled as bundles of nonlinear
springs. The mensical attachments are defined in the same was as described in the Ligaments and Tendons (page 49)
section. In short, insertion points are manually defined from the MR images, and these points are used to create the
attachment’s mesh (Fig. 5.2).

5.1.4 Ligaments and Tendons

Ligaments and tendons are represented as a bundle of nonlinear springs. Bundles are composed of a line of equally
space fibers, where adjacent fibers are connected by tension only corss-springs Fig. 5.2.

a. b. - C.

Fig. 5.2: An example of the (a) points used to define a ligament, (b) the point to point mesh that is generated from the
four points, and (c) the mesh wrapping around the femur and tibia osseous surfaces. The example shows six ligament
fibers that are oriented in the proximal-distal direction, and the connecting springs that are oriented in the anterior-
posterior direction that make up a total of 20 divisions in the mesh. This is a medial view of a right knee. Note that
this is used as an example, and not used to describe the insertion locations or size of any specific ligament.

Note: If in the future, a ligament and/or tendon is being modeled as a continuum, then the geometry should be
segmented (page 7) and reconstructed (page 42), then meshed following the same proceedure as described for meshing
the menisci (page 47).
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Manually Defined Data

For each ligament/tendon mesh, there are two types of data that are manually defined by the user
1. Points that define both insertion areas Fig. 5.2 (a)
2. The correspondence of the points between insertion areas

The MR images are used to manually define the insertions of the ligaments/tendons. Using 3D Slicer, two points are
manually placed in the MR image at the margins of the ligament/tendon’s insertion area. These two points should form
a line that bisects the insertion area. The literature should be used to confirm the relative locations of the insertions
(Table 5.4), and when literature based measurements are available, the ruler tool in 3D Slicer should be used to
verify the ligament/tendon insertion’s size and location. The links in Table 5.4 contain the literature sources used to
define the insertions, and measurements that were referenced to verify the insertion area size and location.

After the points that represent the ligament/tendon’s insertion area have been defined (4 points total, 2 for each end of
the ligament/tendon’s insertion) the user should manually define the corresponding points between insertion sites. The
corresponding points are used to define the fibers at the margins of the ligament/tendon’s insertion area. For example,
in Table 5.4, the anterior point on the tibia’s insertion corresponds with the anterior point of the femur’s insertion.
Due to possible ambiguity, notes for corresponding points in the ACL and PCL bundles are provided on their anatomy
description page Table 5.4.

Mesh Generation

Using the manually defined data, two inputs are needed to define the coarseness of the mesh. Appropriate values should be dete

1. Number of fibers Fig. 5.2
2. Number of divisions Fig. 5.2

The fibers at the margins of the insertion sites are defined using the manually defined points, and additional fibers are
mapped between these fibers. The insertion points of the additional fibers are equally spaced between each manually
defined point. Adjacent fibers are connected with tension only springs, and the locations of these springs are defined
by evenly distributing the same number of points along the length of each fiber.

Due to the use of explicit analysis in Abaqus, there are mass elements defined at every node, and dashpot elements are
defined to be in parallel with every spring element. The material properties of all the elements in the ligament mesh
can be found here: Initial Material Properties (page 60).

5.1. Mesh Creation 50



KneeHub_OKS Documentation Cleveland State University, Release 1

Table 5.4: Ligaments and tendons included in the model, and links to the
descriptions of their anatomy.

Description | File Type Anatomy description
Anteromedial| Spring ACL Anatomy (page 15)
ACL

(amACL)

Posteriolateral Spring ACL Anatomy (page 15)
ACL

(plACL)

Anterolateral | Spring PCL Anatomy (page 17)
PCL

(alPCL)

Posteromedial Spring PCL Anatomy (page 17)
PCL (pm-

PCL)

Superficial Spring MCL Anatomy (page 20)
MCL

Deep MCL Spring MCL Anatomy (page 20)
LCL Spring LCL Anatomy (page 23)
ALL Spring ALL Anatomy (page 25)
PFL Spring PFL Anatomy (page 26)
OPL Spring OPL Anatomy (page 26)
MPFL Spring MPFL Anatomy (page 28)
Quadriceps | Spring Quadriceps Tendon Anatomy (page 34)
Tendon

Patellar Spring PatellarTendonAnatomy
Tendon

Reference State

The ligament spring meshes do not account for wrapping when they are defined. This could lead to unusual recruitment
when defining ligament prestrain. Additionally, nodes that may be tied to the meniscus cannot be identified from the
initial ligament spring mesh.

To account for ligament wrapping when setting up the FE model, an initial FE simulation will be used to define
ligament node positions when wrapping is enforced (Fig. 5.3). The ligament meshing procedures will be used to
define the mesh for the initial simulation, and the results of this simulation will be used to define the node positions in
subsequent simulations (such as passive flexion).

Note: The joint in the reference state is in the same position/orientation as the image state. Ligament prestrain is
defined with respect to the reference state, therefore prestrains are defined with respect to the position/orientation that
the knee was in during imaging.

Method - Reference State

In the initial reference simulation, the femur, tibia, patella, menisci, and cartilage are rigid and fixed. This keeps those
bodies in the same position as in the MR images. To prevent the ligaments from being slack, they will be assigned
a uniform prestrain of -5%. The stiffness of the ligaments will not be changed from their normally assigned values
(Initial Material Properties (page 60)).
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Fig. 5.3: An example of (a) the initial mesh that is defined from insertion point to insertion point data, and (b) the
reference state where the ligament’s mesh wrapped around the femur and tibia surfaces. Note that this is used as an
example, and not used to describe the insertion locations or size of any specific ligament.

The simulation enforces contact between the ligaments and the femur, tibia, patella, menisci, and cartilage. The
results of this simulation are used to define the initial ligament node positions for all subsequent simulations. These
node positions are used when calculating fiber lengths which is used then assigning prestrain. Additionally, the node
positions of the dMCL are used to define which nodes are tied to the medial meniscus (d{MCL and Meniscus Ties

(page 67)).

Note: The reference simulation should be performed after mesh convergence has been established.

Additionally, if there is a change in ligament or medial meniscus geometry, then the reference simulation should be
re-run.

5.2 Coordinate Systems

This section describes the methods used to define the coordinate systems of the femur, tibia, and patella. These
coordinate systems are used to describe tibiofemoral and patellofemoral kinematics.

This describes how the coordinate system is defined using the OpenKnee(s) data set, which consists only of MR
images. These methods consist of manually defining osseous landmarks in the MR images, and using those landmarks
to define the fixed femoral, tibial, and patellar coordinate systems.

These methods use 3D Slicer (https://www.slicer.org/) to visualize the MR images and place fiducials at the desired
locations.
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5.2.1 Femur

Six total fiducial points are used to define the femur’s fixed coordinate system. These methods are similar those
described in [grood_joint_1983]. The MR images do not include the femoral head, so the femur’s SI axis will be
initially defined with points around the femoral shaft. This temporary SI axis is used to define the AP axis. After the
AP axis is defined, the SI axis will be rotated 5 degrees about the AP axis to define the “mechanical” femur SI axis.
The “mechanical” ST axis is taken as the femur’s fixed ST axis.

Fiducial locations:

* F) = Medial femoral epicondyle: The most medial point on the medial femoral condyle (using the axial
view in the MR images).

e F, = Lateral femoral epicondyle: The most lateral point on the lateral femoral condyle (using the axial
view in the MR images).

* F35 = Proximal femoral shaft (anterior): The anterior point on the femoral shaft in the most proximal
slice (using the axial view in the MR images).

¢ F, = Proximal femoral shaft (posterior): The posterior point on the femoral shaft in the most proximal
slice (using the axial view in the MR images).

¢ F5 = Proximal femoral shaft (medial): The medial point on the femoral shaft in the most proximal slice
(using the axial view in the MR images).

¢ Fs = Proximal femoral shaft (lateral): The lateral point on the femoral shaft in the most proximal slice
(using the axial view in the MR images).

Note: Fj, Fy, F5, and Fj should be defined using the same slice in the MR images.

Origin: the midpoint between the medial (F}) and lateral (F5) epicondyles.

Fi+ F

PO'riginF = 2

The femur’s temporary superior-inferior axis (2s7_temyp) 18 defined with the line connecting the midpoint between the
medial (£7) and lateral (F%) epicondyles, and the average of the points digitized around the proximal femoral shaft
(F3-F6).

Fs+ Fy + F5 + Fy
Pproximal = 4

_ _ Ppro;m'mal - POTiginF
ZSI_temp = | |P
P

roximal — POriginFH

The femur’s anatomic anterior-posterior (y4p) axis is defined as the normal to the plane defined with the proximal
femoral shaft center (Pp,ozimaq;) and the medial (F7) and lateral (F5) epicondyles. The y4p axis points anteriorly,
and is defined as

yap = ZSI_temp x CD

Where C'D is a unit vector that points to the right, and is parallel to a line that connects the medial (F) and lateral
(F2)

Note: For a right knee:

— Fy — F
cp— 2= I
|[|[F — Fi]
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For a left knee:

- - F
Cp= 1772
||[F1 — Fhl|

To determine the femur’s fixed zgr axis, zsr_temp Will be rotated 5 degrees about y4p (using the method described
in section 9.2 found here). Recognizing that zs; temyp is already a unit vector that is perpendicular to the unit vector

YAP,
W =yYap X ZSI_temp
ZS1 =ZSI_tempc0s0 + wsind
Where 6 = 5 degrees for a left knee, and # = —5 degrees for a right knee.
The anatomic medial-lateral (x ;) axis points to the right, and is defined with as the cross product between the y 4 p

and zgy axes.

TAP = YApP X 23]

5.2.2 Tibia

Six total fiducial points are used to define the tibia’s fixed coordinate system. These methods are similar those described
in [grood_joint_1983].

Fiducial anatomy:
e T1 = Medial tibial plateau
» T, = Lateral tibial plateau

¢ T3 = Distal tibial shaft (anterior): The anterior point on the tibial shaft in the most distal slice (using the
axial view in the MR images).

» T, = Distal tibial shaft (posterior): The posterior point on the tibial shaft in the most distal slice (using
the axial view in the MR images).

e Ty = Distal tibial shaft (medial): The medial point on the tibial shaft in the most distal slice (using the
axial view in the MR images).

» Ts = Distal tibial shaft (lateral): The lateral point on the tibial shaft in the most distal slice (using the
axial view in the MR images).

Note: T35, T}y, T, and Tg should be defined using the same slice in the MR images.

Origin: defined as the midpoint between the medial (77) and lateral (75) tibial plateau.

T+ T
2

POriginT =

The tibial superior-inferior axis (zgy) is defined as the line between the midpoint of the medial (77) and lateral (7%)
tibial plateau, and the average of the digitized medial and lateral malleolus (75-7%).

The tibial anterior-posterior axis (y4 p) points anteriorly, and is defined as
Yap = zZs1 X AB

Where AB is a unit vector line that points to the right, and is parallel to the line that passes through the medial (77)
and lateral (75) tibial plateau.
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Note: For a right knee:

- T, - T
AB= ————
T2 — 1|
For a left knee:
_ T —Ts
AB= —————
|7 — Ty

The medial-lateral (x,7) axis points to the right, and is defined with as the cross product between the y4p and zg;
axes.

TAP = YAP X 23T

5.2.3 Patella

Four fiducial points are used to define the patella’s fixed coordinate system.
Digitized anatomy:

¢ P, = Most medial point

* P, = Most lateral point

* P53 = Most superior point

* P, = Most inferior point
Origin: defined as the midpoint between the medial (P;) and lateral (P,) points.

P+ P

POriginP = D)

The medial-lateral (xs7) points to the right. For a right knee x,,, is defined as the line passing through the lateral
point () and the origin of the patella’s coordinate system (Po,;ginp. For a left knee xprp, is defined as the line
passing through the medial point (/) and the origin of the patella’s coordinate system (Poyigin p-
o P2 - POriginP
7HP2 - POriginPH

POriginP - Pl
l|Poriginp — P1|

TML—right

TML—left =
The anterior-posterior (y 4 p) points anteriorly, and is defined as
yap = EF X xpp

where EF is a unit vector that points superiorly and is parallel with a line that passes through the inferior (P;) and
superior (Ps) points.

+ P — Py
EF— 311
|| P3 — Pyl

The superior-inferior (zgy) axis points superiorly, and is defined as the cross product between the medial-lateral axis
(zarr), and the anterior-posterior axis (y4p).

2SI = TML X YAP
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5.3 Registration

This section describes how the physical femur, tibia, and patella coordinate systems are registered to their digital
models. Registration is used to define the osseous coordinate systems with respect to the digital model’s coordinate
system. The digial models (usually surfaces) were defined using MR images, therefore the models are defined with
respect to the MR image’s coordinate system. The MR image’s coordiante system will be referred to as the image
coordinate system, and the digial models are initially defined with respect to this coordiante system.

At the end of the registration procedure, there will be femur, tibia, and patella coordinate systems that are defined with
respect to to the image coordinate system.

5.3.1 OpenKnee(s) Registration

Femur

This is a placeholder for the registration methods using OpenKnee(s) data. The first set of OpenKnee(s) data does not
include experimental data, therefore no registration of the physical coordinate systems to the digital models is possible.

Tibia

This is a placeholder for the registration methods using OpenKnee(s) data. The first set of OpenKnee(s) data does not
include experimental data, therefore no registration of the physical coordinate systems to the digital models is possible.

Patella

This is a placeholder for the registration methods using OpenKnee(s) data. The first set of OpenKnee(s) data does not
include experimental data, therefore no registration of the physical coordinate systems to the digital models is possible.

5.4 Connector Elements

This section describes the way that connector elements are used in the FE model. Connector elements are used to
define coordinate systems, and the line of action of the muscles (quadriceps) in the FE model. These elements are
used to apply external loads and to calculate kinematics throughout the FE simulation.

Two nodes are used to define a connector element, and the order that those nodes are specified in the Abaqus input file
determine the positive direction.

All of the connector elements are cylindrical, meaning that they can only rotate and translate along one axis.

5.4.1 Tibiofemoral Coordinate System - Connectors

The fixed femoral and tibial Coordinate Systems (page 52) are used to define the connector elements that make up the
tibiofemoral coordinate system in the FE model.

Nodes

Four nodes are used to define the three connector elements that compuse the tibiofemoral coordinate system.

* Node 1: The origin of the tibia’s fixed coordinate system
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* Node 2: The origin of the femur’s fixed coordinate system
* Node 3: The point where the AP axis intersects the SI axis

* Node 4: The point there the AP axis intersects the ML axis

Fig. 5.4: The nodes that are used to define the connector elements.
Referring to Fig. 5.4, and using the line equation (p; = pg + tv), the points that lie on the AP axis can be written as
(noting that v, U5, and v are unit vectors that are parallel with the x /7, y4p and zg; axes respectively)
Py =P + tavs
Py =Py +t3v3
=Py + tovg + t303
Recognizing that Ps can also be written as P = P; + t1v1, the following expression can be written
P3 =Py + t10
=P + 203 + t303
Py + 1101 =P + ta0p + 303
Rearranging the above equation,

P1 — PQ = —1101 + t202 + t303

Recognizing that the only unknown values in the above equation are ¢1, ¢5, and ¢3, the above equation can be expressed
in matrix form

—v11 V21 w31 |1 Py — Py
—vig Va2 Usa| [t2| = |Pi2 — Pao
—v13 V23 V33| |13 Pz — Po3

where v;; refers to the j index in unit vector i, and Py; refers to the / index in point number k.
The values for ¢; can be solved for in the above equation, and

P; =P +t1vy
Py =P, +t172
Elements

The nodes are used to define the elements in the FE model. These elements are used to apply or measure kinematics,
and apply external loads. The order that the nodes are defined in the Abaqus input file defines the positive direction
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of the element. A minimum of three elements are needed, however three additional elements are added to keep
consistency in kinematic and load descriptions between right and left knees. For example, translation along the y4p
axis has the same sign between left and right knees, however the same rotation about the y 4 p (varus) has an opposite
sign between left and right knees.

The specific ordering of the nodes will change between right and left knees, but the elements will contain the following
nodes:

* Element 1: node 2 and node 4 - medial tibial translation and force
* Element 2: node 4 and node 3 - anterior tibial translation and force
* Element 3: node 1 and node 3 - superior tibial translation and force
* Element 4: node 2 and node 4 - extension rotation and moment

» Element 5: node 4 and node 3 - varus rotation and moment

¢ Element 6: node 1 and node 3 - internal tibial rotation and moment

Ties

Some of the nodes are tied to the femur and tibia geometry
* Node 1: Tied to the tibia
— The node that is at the tibia’s fixed coordinate system origin is rigidly tied to the tibia bone geometry
* Node 2: Tied to the femur

— The node that is at the femur’s fixed coordinate system origin is rigidly tied to the femur bone geometry

5.4.2 Patella Quadriceps Connectors - Connectors

Connector elements are used to apply external loading to the quadriceps tendon. In the absence of experimental data,
the points manually placed in the MR images to define the quadriceps tendon are used to define the line of action
of the quadriceps load (see Ligaments and Tendons (page 49) and Quadriceps Tendon Anatomy (page 34) for more
information on point placement). One node on the connector element is tied to the femur’s fixed coordinate system to
allow it to move with the femur.

Nodes

Two nodes are defined from the points that were manually defined from the MR image during mesh creation (Mesh
creation - Ligaments and Tendons (page 49)). There should be a total of four points defined in the MR image that
correspond to the quadriceps tendon insertion in to the patella (medial and lateral margins), and two points that are
more proximal along the tendon (medial and lateral). These points are used to define the spring representation of the
quadriceps.

e Pj: the medial margin of the quadriceps tendon insertion into the patella
e P, the lateral margin of the quadriceps tendon insertion into the patella
e Pj5: the medial margin of the quadriceps tendon proximal to the patella

e Py: the lateral margin of the quadriceps tendon proximal to the patella
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These points are used to calculate two more points that lie between P;, P> and Ps, P;.

P+ P
P5:%
Ps + P
p6:%

A unit vector is defined that is parallel to the line that intersects P5 and F,

Ps — Ps

=
|| Ps — Ps||

and a point is defined proximal to P; along the line of action,
P; =P +10.0

* Node 1: P, the point proximal to the patella, at the midpoint between the points defined in the MR image Ps
and Py

* Node 2: P, the point that is prixmal to Py along the line of of action defined with P5 and F;.
Elements

One connector element is defined with nodes 1 and 2.

Ties

* Node 1 is rigidly tied to the most proximal nodes in the quadricps mesh

* Node 2 is rigidly tied to the origin of the femur’s fixed coordinate system

5.4.3 Femur and tibia fixed coordinate systems - Connectors

Connectors are placed on the fixed femur and tibia coordinate systems. These connectors can be used to apply loads
or boundary conditions to the femur/tibia’s fixed coordinate system.

Nodes

Connector elements are defined to be coincident with the axes of the femur and tibia fixed coordinate systems. Nodes
are placed on each axis (6 total) and the origin of both coordinate systems is already defined.

Elements

A total of six elements are defined between the femur and tibia fixed coordinate systems. On each coordinate system,
three elements are defined using the node that is defined at the origin, and the nodes that lie on each of the axes.

Ties

All of the nodes that lie on the femur’s fixed coordinate system are rigidly tied to the femur’s bone geometry. Similarly,
all of the nodes that are on the tibia’s fixed coordinate system are rigidly tied to the tibia’s bone geometry.
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5.5 Initial Material Properties

This section describes the material properties that are applied to the geometry in the finite element knee model.

5.5.1 Ligaments and Tendons (spring representation)

The model includes 15 ligament bundles. Stiffness and reference strain of each of these bundles are summarized in
Table 5.5. For each bundle, the stiffness was evenly divided between the springs included in that bundle. The number
of springs will be determined with a convergence study.

i 6% strain

Slack | '

Lenght

Force (N)

Fig. 5.5: The nonlinear force-length curve that is used to define ligament behavior.

Note that every ligament is modeled as having a toe region that ends at 6% strain.

Prestrain

Each ligament is modeled as a bundle of fibers and prestrain (Table 5.5) is defined with respect to each fiber’s length in
the reference state (page 51), therefore the prestrain is defined with respect to each fiber’s length in the joint’s position
during imaging. The prestrain is used to define the slack length (Fig. 5.5).

Stiffness

Stiffness values (k¢q) (Table 5.5) define the ligament bundle’s equivalent stiffness, where each fiber has the same
stiffness. Each fiber in a ligament bundle with n fibers (Fig. 5.6) has a stiffness of ky;; = keq/n. Similarly, there are
m springs (Fig. 5.6) that compose a fiber. Each spring in a fiber has the same stiffness value kg, = m/kfip.
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Adjacent fibers in the ligament mesh are connected with cross springs (Fig. 5.6). There are p = (n — 1)(m + 1) cross
spring in a ligament mesh. each cross spring only carries tension forces, and has a constant stiffness of 10 N/mm.

Fig. 5.6: An example of a ligament mesh with n = 6 fibers in parallel, and are oriented in the superior-inferior
direction. Each fiber contains m = 19 springs in series. There are also p = 100 cross springs that are oriented in the
anterior-posterior direction. The cross springs connect adjacent ligament fibers. Note that this is used as an example,
and not used to describe the insertion locations or size of any specific ligament.

The literature normally reportes stiffness values in units of N/mm or N/e. To avoid limiting potential sources, values
for both unit types are used. Every spring in the finite element model has a force-displacement curve that is similar to
Fig. 5.5. Ligaments with a stiffness with units of N /e have the spring’s stiffness converted to units of N/mm based
on the spring’s length in the reference state (page 51) and the assigned prestrain.
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Table 5.5: Material properties of the ligament and tendons that are mod-

eled as bundles of springs.

Tissue Stiffness Reference Strain Comments

Name

amAcl 2120 (N/strain) [AW12] | -0.01 [HCA+16] | ACL stiffness magnitude from

(page 15) (page 87) (page 87) [AWI2] (page 87) and amACL
to plACL ratio from [KSL+16]
(page 87)

plAcl 2880 (N/strain) [AWI12] | -0.04 [HCA+16] | ACL stiffness magnitude from

(page 15) (page 87) (page 87) [AWI2] (page 87) and amACL
to plACL ratio from [KSL+16]
(page 87)

alPcl 5625 (N/strain) [AWI12] | 0.06 [HCA+16] | PCL stiffness magnitude from

(page 17) (page 87) (page 87) [AWI2] (page 87) and alPCL to
pmPCL ratio from [KSL+16]
(page 87)

pmPcl 3375 (N/strain) [AWI12] | -0.03 [HCA+16] | PCL stiffness magnitude from

(page 17) (page 87) (page 87) [AW12] (page 87) and alPCL to
pmPCL ratio from [KSL+16]
(page 87)

sMclProx 1375 (N/strain) [AW12] | 0.07 [HCA+16] | The average of the anterior middle

(page 20) (page 87) (page 87) and posterior MCL springs reported
in [HCA+16] (page 87)

sMclDist 1375 (N/strain) [AW12] | 0.07 [HCA+16] | The average of the anterior middle

(page 20) (page 87) (page 87) and posterior MCL springs reported
in [HCA+16] (page 87)

dMcl 1000 (N/strain) [AWI12] | 0.03 [AW12] (page 87)

(page 20) | (page 87)

Icl 2000 (N/strain) [AW12] | 0.05 [AW12] (page 87)

(page 23) | (page 87)

all 750  (N/strain) [EKH+15] | 0.05 The prestrain value is arbitrarily de-

(page 25) (page 87) fined

pfl 1000 (N/strain) [EKH+15] | -0.02 [EKH+15]

(page 26) | (page 87) (page 87)

opIMid 1000 /EKH+15] (page 87) 0.03 [EKH+15]

(page 26) (page 87)

Mpfl 294 (N/mm) [HHD+14] | -0.05 [SVL+16]

(page 28) | (page 86) (page 88)

Lpfl 16 (N/mm) [MSIA09] | 0.01 [SVL+16]

(page 29) | (page 87) (page 88)

PT 4334 (N/mm) [HBMA+06] | 0.02 [SVL+16]

(page 29) | (page 86) (page 88)

PMFL 49 (N/mm) [KHC+94] | 0.0 The prestrain value is arbitrarily de-

(page 37) (page 86) fined

aMFL 49 (N/mm) [KHC+94] | 0.0 The prestrain value is arbitrarily de-

(page 37) (page 86) fined

amHorn 125 (N/mm) [ELS+14] | 0.0 The prestrain value is arbitrarily de-

(page 39) (page 87) fined

pmHorn 125 (N/mm) [ELS+14] | 0.0 The prestrain value is arbitrarily de-

(page 39) (page 87) fined

alHorn 150 (N/mm)  [ELS+14] | 0.0 The prestrain value is arbitrarily de-

(page 39) (page 87) fined

plHorn 130 (N/mm)  [ELS+14] | 0.0 The prestrain value is arbitrarily de-

(page 39) (page 87) fined
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5.5.2 Ligaments and Tendons (continuum representation)

If in the future, a ligament and/or tendon is being modeled as a continuum, the tissue will be modeled as a transversely
isotropic material.

Fiber Direction

The fibers are assumed to be uniformly distributed in, and perfectly bonded to the matrix. The fiber directions are
defined in the image state, and run along the length of the ligament. Similar to /NBJvdG+17] (page 87), the ACL and
PCL are split into two fiber orientations each. These different orientations represent the amACL, plACL, alPCL, and
pmPCL bundles of the ligament.

Material Model

Ligament/tensons will be modeled with a transversely isotropic hyperelastic material model. A Holzapfel-Gesser-
Ogden [NBJvdG+17] (page 87) hyperelastic model will be used. The properties for the ligament and tendons are
shown in Table 5.6. Tissues that were not modeled in /NBJvdG+17] (page 87) were assigned the same values as the
MCL.
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Table 5.6: Material properties of the ligament and tendons if they are
modeled as a continuum. Note that all of the K and K5 come from

[NBJvdG+17].
Tissue Name | K, Ky prestrain Comments
amAcl 52.27 5.789 0.03
(page 15) [NBJvdG+17]
(page 87)
plAcl 52.27 5.789 0.03
(page 15) [NBJvdG+17]
(page 87)
PCL 46.18 2.758 0.06
[HCA+16]
(page 87)
MCL 41.21 5.351 0.07
(page 20) [HCA+16]
(page 87)
dMcl 41.21 5.351 0.03 [AWI2] | The K; Ko values are taken from the
(page 20) (page 87) MCL
lcl (page 23) | 41.21 5.351 0.05 [AWI2]
(page 87)
all (page 25) | 41.21 5.351 0.05 The prestrain value is arbitrarily defined
and the K; K values are taken from the
MCL
pfl (page 26) | 41.21 5.351 -0.02 The K; K> values are taken from the
[EKH+15] MCL
(page 87)
opIMid 41.21 5.351 -0.03 The K, K5 values are taken from the
(page 26) [EKH+15] MCL
(page 87)
Mpfl 41.21 5.351 -0.05 The K; K5 values are taken from the
(page 28) [SVL+16] MCL
(page 88)
Lpfl 41.21 5.351 0.01 The K; K, values are taken from the
(page 29) [SVL+16] MCL
(page 88)
PT (page 29) | 41.21 5.351 0.02 The K; K, values are taken from the
[SVL+16] MCL
(page 88)
PMFL 41.21 5.351 0.0 The prestrain value is arbitrarily defined
(page 37) and the K7 K> values are taken from the
MCL
aMFL 41.21 5.351 0.0 The prestrain value is arbitrarily defined
(page 37) and the K7 K5 values are taken from the
MCL
Meniscal 41.21 5.351 0.0 The prestrain value is arbitrarily defined
Horns and the Ky K> values are taken from the
(page 39) MCL
Prestrain

A uniform prestrain will be assigned to the ligament/tendon /MEHW16] (page 87) with the prestrain values defined in

Table 5.5.
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5.5.3 Cartilage

The model includes 4 cartilage geometries. The cartilage is modeled using an elastic foundation model [LKST15]
(page 87). Contact pressures are calculated using a pressure-overclosure relationship.

Pressure 1-v)E 1

Overclosure ~ (1+v)(1—2v)t

Table 5.7: Material properties of the cartilage geometries.
Tissue Name E (MPa) Poisson’s ratio Thickness (mm)
Femoral Cartilage 12 [DKB10] (page 87) | 0.45 [DKBI0] (page 87) | 3 [LKSTI5] (page 87)
Medial Tibial Cartilage | 12 [DKBI0] (page 87) | 0.45 [DKBI10] (page 87) | 3 [LKST15] (page 87)
Lateral Tibial Cartilage | 12 [DKBI10] (page 87) | 0.45 [DKBI10] (page 87) | 3 [LKSTI5] (page 87)
Patellar Cartilage 12 [DKBI10] (page 87) | 0.45 [DKB10] (page 87) | 3 [LKST15] (page 87)

5.5.4 Menisci

The model includes two meniscus geometries. The menisci are modeled as transversely isotropic linearly elastic
[DKB10] (page 87). The circumferential elastic modulus is greater than the axial and radial values. Young’s modulus
and Poisson’s ration in the axial direction is equal to radial direction.

Table 5.8: Material properties of the menisci geometries.

Tissue Name Ecircumferential Veircumferential Eorviat = FEradial | Vazial = Vradial
(MPa) (MPa)

Medial Menis- | 120 [DKBI10] | 0.45 [DKBI10] | 20 [DKBI10] | 0.3 [DKBI10]

cus (page 87) (page 87) (page 87) (page 87)

Lateral Menis- | 120 [DKBI10] | 0.45 [DKBI10] | 20 [DKBI0] | 0.3 [DKBI10]

cus (page 87) (page 87) (page 87) (page 87)

5.5.5 Mass Properties

Mass properties are required because we are using an explicit finite element model. Nominal masses are assigned
to reduce the amount of intertial effects in the model. Every ligament node is assigned a mass of 0.0001 kg. The
cartilage and menisci are assigned a density of 0.000001 kg/mm”2. The bones are rigid bodies, however the connector

elements that are rigidly attached to the bones have a rotational inertia of 111 = Iso = I33 = 0.0001 kg*mm”2, and
112 = 123 = 113 =0.0.

5.6 Interactions and Ties

5.6.1 Ineraction - Ligaments and Tendons

These interactions are defined for both spring and continuum representation of ligaments and tendons.

Contact

A pressure-overclosure relationship is defined between the connective tissue and bodies that the tissue may contact.
Contact damping is also specified so collisions between the tissues and contact surfaces is not perfectly elastic. This
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reduces the oscillation of the connective tissues in the simulation. To save on computational cost, interactions are only
defined between connective tissues and nearby bodies Table 5.9.

Table 5.9: Ligament and tendon interactions with other bodies in the

simulation.
Name Femur | Tibia Patella | Femoral | Tibial Patellar | Medial | Lateral
Carti- Carti- Carti- Menis- | Menis-
lage lage lage cus cus
X X

amACL

plACL

alPCL

pmPCL
sMCLProx
sMCLDist
dMCL

LCL

ALL

PFL

OPL

MPFL

LPFL

Patellar Tendon
Quadriceps Tendon
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PP | | | X
PP > | | R
PP D | | | X

>
>
>
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A linear pressure-overclosure relationship is specified, where the interaction between the bone surface and a ligament
node begins when the node has a clearance of 0.01 mm (i.e the node is not yet touching or overclosing the surface).
Specifically, the relationship is a contact force-overclosure relationship. This is a force-overclosure relationship, and
not a pressure-overclosure relationship because the ligament surface is defined as a node-surface. As the node over-
closure increases, the contact force increases at a rate of 990 N/mm.

The Abaqus input for this interaction is defined as:

*Surface Behavior, pressure-overclosure=TABULAR
0.0e3, -0.01

1.0e3, 1.0

+Contact Damping, definition=DAMPING COEFFICIENT
0.25,

Ties/Connections

Insertion sites

The nodes that define each ligament/tendon fiber’s insertion are rigidly tied to the corresponding bone’s fixed coordi-
nate system.

If in the future, a ligament and/or tendon is being modeled as a continuum, then the nodes at the ligament/tendon’s
insertion will be defined with a nearest neighbor search between the body that the tissue inserts into and the surface
nodes of the ligament/tendon.
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dMCL and Meniscus Ties

The deep MCL (M CL Anatomy (page 20)) inserts into the medial meniscus. To simulate this anatomy, one node from
each fiber in the SMCL mesh are rigidly tied to the surface of the medial meniscus. These nodes are identified from
the reference simulation results (Reference State (page 51)). It is assumed that the dJMCL is in contact with the medial
meniscus in the reference simulation results. The dIMCL mesh will be refined until a every fiber has at least one node
in contact with the medial meniscus. The nodes that are tied to the medial meniscus are defined with a nearest neighbor
search.

If in the future, the dMCL is being modeled as a continuum, then the dMCL geometry should have ties to the medial
meniscus. The surface nodes that are closest to the medial meniscus (defined with a nearest neighbor search) will be
rigidly tied to the medial meniscus’ surface.

5.6.2 Interaction - Bone, Cartilage, Meniscus

Contact between the articulating surfaces and menisci is defined with a frictionless pressure-overclosure relationship. There are

1. Femoral cartilage - tibial cartilage

Femoral cartilage - lateral meniscus
Femoral cartilage - medial meniscus
Femoral cartilage - patellar cartilage

Tibial cartilage - lateral meniscus

S T i

Tibial cartilage - medial meniscus

Cartilage Contact

The cartilage is modeled as a rigid body, and contact pressures are calculated using pressure-overclosure relationship
[LKST15] (page 87)[halloran_comparison_2005]. It is assumed that the cartilage has a constant thickness of 3 mm
[LKST15] (page 87).

Overclosure (1 +v)(1 — 2v)
Where v = 0.45,t = 3 mm [LKSTI15] (page 87), and I = 12 MPa [DKBI10] (page 87).

Pressure 1-v)E 1
t

Menisci Contact

A pressure-overclosure relationship is used to model the contact interaction between the articulating surfaces and the
menisci. A “softened” nonlinear pressure-overclosure relationship Fig. 5.7 is used to promote the stability of the
model.

*SURFACE BEHAVIOR, PRESSURE-OVERCLOSURE=EXPONENTIAL
0.01, 0.1, 75

The above specifies a pressure-overclosure relationship. The first value (¢ in Fig. 5.7) specifies that two surfaces
begin to interact when the surfaces are 0.01 mm apart (out of contact), and reach a contact pressure of 0.1 MPa (pg in
Fig. 5.7) when the surfaces are in contact with zero overclosure. The maximum pressure is set to 225 MPa (K ,,,4; In
Fig. 5.7). This maximum pressure is derived from an elastic foundation equation

Overclosure (14 v)(1 — 2v)

Pressure 1-v)E 1
t
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Figure 37.1.2-5 Exponential "softened” pressure-overclosure relationship in Abaqus/Explicit.

Contact
pressure

e

Exponential pressure-overclosure relationship

Clearance c, Cverclosure
>

Fig. 5.7: The exponential pressure overclosure relationship from the Abaqus 6.14 documentation.

where v = 0.45,t = 3, and £ = 60 MPa. Note that ¢ = 3 assumes a uniform thickness of 3 mm, which approximates
cartilage thickness [LKST15] (page 87). Also note that F is five times larger than a normal value for cartilage (12 MPa
[DKBI10] (page 87)). This is increased to limit potential overclosure between surfaces while limiting the maximum
pressure-overclosure stiffness.

Ties/Connections

The cartilage and meniscal attachemnts are defined as being perfectly bonded to the bone.

The medial meniscus has ties with the dJMCL. This is described elsewhere ({MCL and Meniscus Ties (page 67)).
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CHAPTER
SIX

SIMULATION STEPS AND BOUNDARY CONDITIONS

This section describes the specific steps that are used in an Abaqus FE simulation. Each documented step should describe the fo

* Description: the general purpose of the step
* Interactions: the interactions that are activate in this step

* Kinematic boundary conditions: the kinematic boundary conditions that are being assigned, and where
they are being applied

* Kinetic boundary conditions: the external loads that are being applied to the model, and where they are
being applied

6.1 Simulation Incrementation (time-step)

The time-step for the simulation defines the incrementation through the simulation’s steps. This value will be auto-
matically determined by the Abaqus software.

The automatic controls for the time-step are dependant on the smallest element size in the solid meshes. If the
simulation is unstable, or the time-step is prohibitively small, then the solid geometry (meniscus) with the smallest
element will be remeshed.

If remeshing is not sufficient to yield a simulation with a reasonably large time-step, then mass scaling will be used to
increase the time steps used in the simulation.

6.2 Step Time

The total amount of time that is specified for each step is referred to as step time. Unless noted in the step’s description,
the total time for each step is 1 second.

6.3 Simulation Loading Cases

The steps that makeup an FE simulation for different loading cases:

6.3.1 Reference Simulation

This section describes the specific steps and boundary conditions that are being used during an Abaqus FE simulation
that is used to define the reference ligament meshes (described here: Reference State (page 51)).
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Note: The femur, tibia, patella, cartilage, and menisci do not move or deform in this simulation. They remain in the
same position as in the MR image throughout. The purpose of this simulation is to define the position of ligament and
tendon mesh nodes so they do not overclose any other bodies.

In this simulation:
e The femur, tibia, patella, cartilage, and menisci are fixed in all DOF
* The femur, tibia, patella, cartilage, and menisci are rigid

* Ligaments and tendons are defined with a prestrain of -5%

There are three steps for this simulation:
1. Initial settle (page 70)
2. Wrap bones (page 71)
3. Wrap soft tissue (page 72)

Initial settle

Ligaments may be overclosing other bodies by a large amount at the beginning of a simulation (due to the way that
the ligament meshes are defined). Additionally, the ligaments may be assigned a prestrain where they will be carrying
load at the start of the simulation. During pilot testing it was noticed that ligaments are more stable if there is an initial
step where there are no active interactions between the ligaments and other surfaces.

The total time for this step is 0.01 seconds.

Interactions

There are no ligament interactions, and the other geometry is rigid and fixed, so there are no need to define interactions
in this step.

Kinematic Boundary Conditions

Femur

The femur is fixed in all degrees of freedom throughout this step.

Tibia

The tibia is fixed in all degrees of freedom throughout this step.

Patella

The proximal nodes in the quadriceps tendon will be fixed in all degrees freedom in this step.

The patella is fixed in all degrees of freedom throughout this step.
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Kinetic Boundary Conditions

Femur

No external loads are applied to the femur in this step.

Tibia

No external loads are applied to the tibia in this step.

Patella

No external loads are applied to the patella or the quadriceps tendon in this step.

Wrap bones

The ligament and tendon meshes are defined based on their insertion sites, and they may be overclosing other bodies
in the simulation. This step activates the ligament and tendon interactions with the femur, tibia, and patella. These
bodies are the first to have ligament interactions because their kinematics will remain fixed.

The total time for this step is 0.1 seconds.

Interactions

The ligament/tendon interactions with the osseous femur, tibia, and patella are activated. Interactions of the ligaments
with the menisci and cartilage are still inactive in this step because the amount of overclosure may lead to instability.

Table 6.1: Active interactions between different bodies and structures

during the Wrap bones step.
Name Femur Tibia Patella | Femoral | Tibial Patellar | Medial Lateral
Carti- Carti- Carti- Menis- | Menis-
lage lage lage cus cus

amACL

plACL

alPCL

pmPCL
sMCLProx
sMCLDist
dMCL

LCL

ALL

PFL

OPL

MPFL

LPFL

Patellar Tendon
Quadriceps Tendon
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Kinematic Boundary Conditions

Femur

The femur is fixed in all degrees of freedom throughout this step.

Tibia

The tibia is fixed in all degrees of freedom throughout this step.

Patella

The proximal nodes in the quadriceps tendon will be fixed in all degrees freedom in this step.

The tibia is fixed in all degrees of freedom throughout this step.

Kinetic Boundary Conditions

Femur

No external loads are applied to the femur in this step.

Tibia

No external loads are applied to the tibia in this step.

Patella

No external loads are applied to the patella or the quadriceps tendon in this step.

Wrap soft tissue

The previous step activated ligament interactions with the bones, and this step activates ligament interaction with the
cartilage and menisci.

The total time for this step is 0.1 seconds.

Interactions

The interactions from the previous step are still active, and the ligament/tendon interactions with the cartilage and
menisci are activated. This step activates the remaining interactions that are being defined for the simulation.
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Table 6.2: Active interactions between different bodies and structures
during the Wrap soft tissue step.

Name Femur Tibia Patella | Femoral | Tibial Patellar | Medial Lateral
Carti- Carti- Carti- Menis- | Menis-
lage lage lage cus cus

amACL X X X X X X

plACL X X X X X X

alPCL X X X X X X

pmPCL X X X X X X

sMCLProx X X X X X

sMCLDist X X X X X

dMCL X X X X X

LCL X X

ALL X X X X

PFL X X X X X

OPL X X X X

MPFL X X X

LPFL X X X

Patellar Tendon X X X

Quadriceps Tendon | x X

Kinematic Boundary Conditions

Femur

The femur is fixed in all degrees of freedom throughout this step.

Tibia

The tibia is fixed in all degrees of freedom throughout this step.

Patella

The proximal nodes in the quadriceps tendon will be fixed in all degrees freedom in this step.

The patella is fixed in all degrees of freedom throughout this step.

Kinetic Boundary Conditions

Femur

No external loads are applied to the femur in this step.

Tibia

No external loads are applied to the tibia in this step.
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Patella

No external loads are applied to the patella or the quadriceps tendon in this step.

6.3.2 Passive Flexion
This section describes the specific steps and boundary conditions that are being used during an Abaqus FE simulation
of passive flexion.
There are four steps in the passive flexion simulation cycle:
1. Initial settle (page 74)
2. Load Patella (page 75)
3. Initial orientation to 0 flexion (page 76)

4. Fassive flexion (page 77)

Initial settle

Before this simulation, the ligament and tendon meshes have been defined from the results of the reference simulation
(page 69), so there is no overclosure between the ligaments, tendons and other bodies.

The total time for this step is 0.01 seconds.

Interactions

All of the desired interactions are active in this step.

Table 6.3: Active interactions between different bodies and structures
during the Wrap soft tissue step.

Name Femur | Tibia Patella | Femoral | Tibial Patellar | Medial | Lateral
Carti- Carti- Carti- Menis- | Menis-
lage lage lage cus cus

amACL X X X X X X

plACL X X X X X X

alPCL X X X X X X

pmPCL X X X X X X

sMCLProx X X X X X

sMCLDist X X X X X

dMCL X X X X X

LCL X X

ALL X X X X X

PFL X X X X X

OPL X X X X X

MPFL X X X

LPFL X X X

Patellar Tendon X X X

Quadriceps Tendon | x X

Femoral Cartilage X X X X

Tibial Cartilage X X
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Kinematic Boundary Conditions

The rigid bodies are fixed in all degrees of freedom.

Femur

The femur is fixed in all degrees of freedom throughout this step.

Tibia

The tibia is fixed in all degrees of freedom throughout this step.

Patella

The proximal nodes in the quadriceps tendon will be fixed in all degrees freedom in this step.

The patella is fixed in all degrees of freedom throughout this step.

Kinetic Boundary Conditions

There are no external loads.

Femur

No external loads are applied to the femur in this step.

Tibia

No external loads are applied to the tibia in this step.

Patella

No external loads are applied to the patella or the quadriceps tendon in this step.

Load Patella

The patella was fixed in the previous step. This step removes the kinematic constraint on the patella, and loads the
quadriceps tendon with a nominal load.

The total time for this step is 0.25 seconds.

Interactions

The interactions from the previous step are still active. All of the desired interactions should still be active in this step.
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Kinematic Boundary Conditions

Femur

The femur is fixed in all degrees of freedom throughout this step.

Tibia

The tibia is fixed in all degrees of freedom throughout this step.

Patella

The proximal nodes in the quadriceps tendon are no longer fixed, they have no boundary conditions (note that their
motion is still constrained with the patellar quadriceps connector (page 58)).

No kinematic boundary conditions are specified for the patella.

Kinetic Boundary Conditions

Femur

No external loads are applied to the femur in this step.

Tibia

No external loads are applied to the tibia in this step.

Patella

A 20 N load is applied to the patellar quadriceps connector (page 58). This load is linearly increased from 5 N to 20
N throughout this step.

Initial orientation to 0 flexion

This step moves the femur from it’s initial position to 0 degrees flexion. The femur’s flexion angle is controlled, and is
free to move in other degrees of freedom. There is a nominal 20 N compressive load applied to the femur throughout
this step.

Interactions

The orientation of the knee at the end of this step is orientation at the beginning of the passive flexion test. As such,
all of the interactions that are desired for the passive flexion test are active during this step. These interactions are still
active from the previous steps.
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Kinematic Boundary Conditions
Femur

For the passive flexion test, the femur will be unconstrained in all directions except for rotation about the flexion axis.
The angle about the femur’s flexion axis will be assigned throughout this step.

The initial orientation of the knee is known after the femur and tibia coordinate systems are defined with respect to
the MR image’s coordinate system (more details in Coordinate Systems (page 52)). The initial flexion angle is used to
define the kinematic boundary condition for the femur during the initial step. The rotation is applied to the connector
element that corresponds to the flexion axis (page 56).

¢ Change the flexion from the initial value to zero

— The femur is free to move in other degrees of freedom

Tibia

The tibia will be fixed in all degrees of freedom.

Patella

No kinematic boundary conditions are applied to the patella or the quadriceps tendon.

Kinetic Boundary Conditions
Femur

To reduce the instability in the simulation, a nominal 20 Ncompressive force will be applied to the femur during this
step. This force will be applied to the connector element that corresponds to the SI axis (page 56). No other external
forces will be applied to the femur.

Tibia

No external loads are applied to the tibia in this step.

Patella

To reduce the potential for instability, a 20 N load is applied to the patellar quadriceps connector element (page 58).
This load is maintained at 20 N throughout this step.

Passive flexion

This step simulates passive flexion. The femur is kinematically controlled in flexion, and free to move in other degrees
of freedom.

The total time for this step is 2 seconds.
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Interactions

The interactions from the previous step are maintained in this step. All of the desired interactions for the simulation
are active in this step.

Table 6.4: Active interactions between different bodies and structures
during the Passive flexion step.

Name Femur | Tibia Patella | Femoral | Tibial Patellar | Medial | Lateral
Carti- Carti- Carti- Menis- | Menis-
lage lage lage cus cus

amACL X X X X X X

plACL X X X X X X

alPCL X X X X X X

pmPCL X X X X X X

sMCLProx X X X X X

sMCLDist X X X X X

dMCL X X X X X

LCL X X

ALL X X X X X

PFL X X X X X

OPL X X X X X

MPFL X X X

LPFL X X X

Patellar Tendon X X X

Quadriceps Tendon | x X

Femoral Cartilage X X

Tibial Cartilage X X

Kinematic Boundary Conditions
Femur

For the passive flexion test, the femur will be unconstrained in all directions except for rotation about the flexion axis.
The angle about the femur’s flexion axis will be assigned throughout this step.

¢ Passive flexion step: Increase the flexion angle from 0 to 90 degrees

— The femur is free to move in other degrees of freedom

Tibia

The tibia will be fixed in all degrees of freedom in this step.

Patella

No kinematic boundary conditions are applied to the patella or the quadriceps tendon.

Kinetic Boundary Conditions
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Femur

To reduce potential instability in the simulation, a nominal compressive force of 20 N will be applied to the femur
during this step. This force will be applied along the joint coordinate system’s SI axis, which is the tibia’s fixed SI
axis. No other external forces will be applied to the femur.

Tibia
No external loads are applied to the tibia in this step.

Patella

To reduce the potential for instability, a 20 N load is applied to the patellar quadriceps connector element (page 58).
This load is maintained at 20 N throughout this step.
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CHAPTER
SEVEN

MODEL OUTPUTS

This section describes the outputs that are measured from the simulation results. Time is used to index the application
of external loads and prescribed displacements/motions. The model outputs can be measured at specific time points
throughout the test cycle. Custom Python scripts are used to extract these measurements from the simulation’s results
file (.odb for Abaqus).

7.1 Contact

Contact measurements can be directly measured from the simulation. Between each contact pair (Table 7.1) the contact
metrics are:

» Total contact area
* Total contact force (magnitude)

* Contact pressure distribution

Table 7.1: The contact pairs where contact area and total contact force
are measured from.

Femoral cartilage Tibial cartilage - medial
Femoral cartilage Tibial cartilage - lateral
Femoral cartilage Patellar cartilage

7.2 Joint Kinematics

The connector elements (page 56) are used to measure joint kinematics from the simulation results. The connector
elements are aligned with the joint’s coordinate system, so joint translations and rotation are directly related to each
connector’s translation and rotation. Note that the connector’s initial position is defined when the joint is in the image
state (i.e. the joint position/orientation in the MR image), so the initial joint position/orientation should be taken into
account when measuring joint kinematics.

7.3 Ligament Force

The ligament force is defined as the magnitude of force carried by the ligament. It is taken as the sum of forces
magnitudes carried by each ligament fiber. Each fiber’s force is taken as the average force magnitude carried by the
elements in the fiber. The elements in each fiber should carry a similar force magnitude, however the forces may be
different due to ligaments wrapping around surfaces.
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CHAPTER
EIGHT

ANNOTATED BIBLIOGRAPHY

This section is for internal MCLS lab use. It summarizes information gathered from the literature.

8.1 Continuum Ligaments

[DKB10] (page 87) modeled four tibiofemoral ligaments (ACL, PCL, MCL, LCL), and four patellofemoral ligaments
and tendons (MPL, LPL, quadriceps tendon, and patellar tendon). The figures also appear to show a medial patellar
retinaculum, however the text does not describe structures or their material properties. The tibiofemoral ligaments,
MPL, and LPL were modeled as fiber reinforces structures with a transversely isotropic hyperelastic material model.
The quadriceps and patellar tendon were modeled with a neo-Hooken model.

[NBJvdG+17] (page 87) modeled the ACL, PCL, MCL, LCL, and patellar tendon were modeled with a Holzapfel-
Gesser-Ogden (HGO) hyperelastic material model. The fiber orientation of the ACL was split into two groups (anterior
and posterior). Thermal loading was used to apply initial strain, with a negative expansion coefficient assigned to each
ligament.

8.2 Cartilage

[PCMDO06] (page 88) modeled cartilage as a single phase linear elastic material
* E=5Mpa
e v=0.46
[KwonOhRyongKangKyoungTakSonJuhyun+13] (page 88) and [KKS+17] (page 88) cited [PCMD06] (page 88) in their methods, &

* E=20Mpa
e v=0.46

[KKS+17] (page 88) modeled the interface between the cartilage and bone as fully bonded. A pressure-overclosure
relationship was used to model articular contact.

[DKB10] (page 87) modeled the cartilage as isioropic linearly elastic
* E=12Mpa
e =045

[DHRJ03] (page 88) modeled the artilage as isotropic linear elastic. Frictionless contact was modeled. Thier convergence study
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e E=15Mpa
e v=0475
[LKST15] (page 87) modeled cartilage contact with a nonlinear elastic foundation formulation.
* E=5Mpa
e =045
* 3 mm uniform thickness
[NBJvdG+17] (page 87) modeled the cartilage as a nonlinear Neo-Hookean hyperelastic isotropic material.
e C19 = 0.86 MPa
e D=0.048MPa!

= Cio(ly —3) + %(J— 1)

8.3 Meniscus

[PCMDO06] (page 88) modeled the meniscus as a single phase linear elastic material
* E=59 Mpa
e v=20.49

[KKS+17] (page 88) modeled the meniscus as homogeneous linearly elastic and transversely isotropic. A hexahedral
mesh was aligned to the circumferential direction of the model to define local element coordiante systems. Linear
springs were used to attach meniscal horns to bone. A pressure-overclosure relationship was used to model articular
contact.

[DKB10] (page 87) modeled the menisci as transversely isotropic linearly elastic
e E.;, =120 Mpa
* veir = 0.45
* Eazial = Etransverse = 20 Mpa

* Vazial = Viransverse = 0.3

[DKB10] (page 87) modeled the meniscal horns as isotropic, linearly elastic, citing that their properties were poorly understood

* E=120 Mpa
e v=045

[NBJvdG+17] (page 87) modeled the meniscus with a Holzapfel-Gesser-Ogden (HGO) hyperelastic model. Meniscal
attachments were modeled as bundles of tension-only nonlinear springs

Table 8.1: Meniscal attachment properties [NBJvdG+17]

Attachment Name Stiffness (N/mm) | Number of Springs
Horn 400 4
anterior transverse ligament Not reported 3
anterior and posterior meniscofemoral ligaments | 49 1
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[DHRJO3] (page 88) performed a sensitivity study on how meniscal properties affect contact metrics. The meniscal
horn attachments were modeled as linear springs. Frictionless contact was modeled. Thier convergence study showed
that 4 layers of elements were needed to model the meniscus.

The experimental component of the study used pressure-sensitive film to measure contact under 400 N and 1200 N
compressive loads at 0 and 15 degrees flexion. A finite element model was developed, and a simplified sampling
technique was used to define how sensitive the contact metrics were to assigned material properties.

Table 8.2: Meniscal sensitivity parameters from [DHRJ03]

Parameter Initial Value Lower Bound Upper Bound
Shear modulus G,y = | 57.5 22.7 77.7
G, (MPa)

Transverse ligament | 200 50 900
stiffness (N/mm)

Total stiffness of horn | 2000 500 30000
attachment (N/mm)

Poisson’s ratio v,.g = | 0.3 0.1 0.35
V20

Poisson’s ratio v, 0.2 0.1 0.4
E, = E, (MPa) 20 15 60

Ey (MPa) 150 100 200

This study concluded that the contact metrics were sensitive to the meniscal circumferential modulus (Ejy), axial/radial
modulus (F, = E.), and the total horn stiffness.
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